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Introduction

Silicon Graphics O2+ Workstation Hardware Reference Guide is your guide to installing,
troubleshooting, and repairing your workstation. Specifically, it explains how to:

• Set up the workstation, including an overview of the hardware (Chapter 1, “Getting
Started”).

• Install and remove memory and option boards (Chapter 2, “Installing or Removing
Memory and Option Boards”).

• Install and remove internal and external peripheral devices (Chapter 3, “Installing
or Removing Peripherals”).

• Diagnose hardware problems (Chapter 4, “Troubleshooting”).

• Order and replace faulty parts (Chapter 5, “Ordering, Removing, Upgrading,
Installing Replacement Parts”).

• Create a safe and comfortable environment for your workstation and maintain the
system correctly (Chapter 6, “Safety and Regulatory Information”).

• Find technical specifications (Appendix A, “Technical Specifications”).

Related Publications

Silicon Graphics O2+ Workstation User’s Guide contains additional information that may be
helpful. For more information about related publications, see “Other Sources of
Information” in Chapter 1.

To obtain SGI documentation, see the SGI Technical Publications Library at
http://techpubs.sgi.com.
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Conventions

The following conventions are used throughout this document:

Reader Comments

If you have comments about the technical accuracy, content, or organization of this
document, please contact SGI. Be sure to include the title and document number of the
manual with your comments. (Online, the document number is located in the front
matter of the manual. In printed manuals, the document number is located at the bottom
of each page.)

You can contact us in any of the following ways:

• Send e-mail to the following address:

techpubs@sgi.com

• Use the Feedback option on the Technical Publications Library Web page:

http://techpubs.sgi.com

• Contact your customer service representative and ask that an incident be filed in the
SGI incident tracking system.

Convention Meaning

command This fixed-space font denotes literal items such as commands, files,
routines, path names, signals, messages, and programming language
structures.

variable Italic typeface denotes variable entries and words or concepts being
defined.

user input This bold, fixed-space font denotes literal items that the user enters
in interactive sessions. Output is shown in nonbold, fixed-space font.

[] Brackets enclose optional portions of a command or directive line.

... Ellipses indicate that a preceding element can be repeated.

manpage(x) Man page section identifiers appear in parentheses after man page
names.
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• Send mail to the following address:

Technical Publications
SGI
1600 Amphitheatre Pkwy., M/S 535
Mountain View, California 94043-1351

• Send a fax to the attention of “Technical Publications” at +1 650 932 0801.

SGI values your comments and will respond to them promptly.
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Chapter 1

1. Getting Started

This chapter contains an overview of the exterior of the workstation and explains how to
connect the parts of your workstation. The following topics are covered:

• “Overview”

• “Checking Your Shipment”

• “Setting Up the O2+ Workstation”

• “Registering Your Workstation”

• “Other Sources of Information”

• “Turning the Workstation On or Off”

• “Setting Up the O2Cam Digital Video Camera”

• “Securing the O2+ Workstation”

• “Locating Your Workstation’s Serial Number”

Overview

Take a moment to familiarize yourself with your workstation. Note that some models do
not have video connectors on the side or rear panel.

To see an overview of the workstation, technical specifications, and ergonomic
information in a Web browser, see Hardware Central. Or, if you are viewing this on a
remote server, see Appendix A, “Technical Specifications”.
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Figure 1-1 shows the controls on the front of the workstation.

Figure 1-1 Front View of the O2+ Workstation

Power button (    )LEDReset

CD eject 
button

Volume
down/up
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Figure 1-2 shows the rear view of the RM7000class workstation.

Figure 1-2 Rear View of the O2+ RM7000class Workstation
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Figure 1-3 shows the rear view of the R12000class workstation.

Figure 1-3 Rear View of the O2+ R12000class Workstation
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Figure 1-4 shows the audio and video ports on the side panel.

Figure 1-4 Side Panel Audio and Video Ports
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Checking Your Shipment
1. Check that you received all the parts shown in Figure 1-5.

Figure 1-5 O2+ Workstation Parts
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Setting Up the O2+ Workstation

Follow these steps to set up your workstation. The setup card that comes with the
workstation also contains this information.

1. Connect the keyboard and the mouse to the workstation (Figure 1-6).

Figure 1-6 Connecting the Keyboard and Mouse to the Workstation

2. Connect the Ethernet 10-Base T or 100-Base T network cable to the Ethernet RJ45
connector on the rear of the workstation (Figure 1-7). If you do not have an Ethernet
connection in your office, check with your system administrator.

The O2+ workstation supports Ethernet 10-Base T and 100-Base T. For optional
networking PCI solutions supported on your workstation, contact your SGI service
provider.
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3. If you own an O2Cam, connect it to the workstation (Figure 1-7).

Figure 1-7 Connecting the Network Cable and the Camera to the Workstation
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4. Connect the monitor cable to the workstation and to the monitor (Figure 1-8).

Figure 1-8 Connecting the Monitor to the Workstation

R         G        B       HD       VD

1(HD15)

2 (BNC)

1
(HD15)
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5. Connect the power cables as follows (Figure 1-9).

• Connect one power cable to the monitor and to a working wall outlet.

• Connect the other power cable to the workstation and to a working wall outlet.

Caution: Always remove the power cable before removing the system module to
upgrade or replace parts.

Figure 1-9 Connecting the Power Cables to the Monitor and to the Workstation

!

R         G        B       HD       VD

1(HD15)

2 (BNC)

CAUTION

Always disconnect
the power cable
before removing

the system module.
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6. Turn on the monitor and the workstation (Figure 1-10).

Figure 1-10 Turning On the Monitor and the Workstation

Ergonomics Information

You can increase the comfort and safety of your work environment, and decrease your
chances of repetitive strain injuries, by following the human factors guidelines provided
in “Human Factors Guidelines for Setting Up Your O2+ Workstation” in Chapter 6.

1

2
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Registering Your Workstation

The Register&Win icon on your desktop or in your Applications Icon catalog provides
a quick and easy way to register your workstation online. You can return the information
via e-mail, the Internet, fax, or postal mail.

Registering your workstation ensures that you receive timely warranty coverage,
qualifies you for quarterly raffle prizes, and allows you to give SGI feedback.

Other Sources of Information

The printed Silicon Graphics O2+ Workstation User’s Guide contains all the information you
need when your workstation is turned off and you cannot access online documentation.
Additional information such as a hardware overview with 3D animation, technical
specifications, cable pinout assignments, and regulatory statements are in this manual,
the Silicon Graphics O2+ Workstation Hardware Reference Guide.

This section provides information about five resources for obtaining other sources of
information, as follows:

• “IRIS InSight Document Library”

• “CD Installation”

• “Quick Answers”

• “InfoSearch”

• “SGI Technical Publications Library”

IRIS InSight Document Library

Online books are located in the IRIS InSight Document Library. From the Toolchest, select
Help > Online Books.

Figure 1-11 Insight Icon
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To locate the online version of this book, from the Toolchest on your desktop, select Help
> Online Books > SGI End User > Silicon Graphics O2+ Workstation Hardware Reference
Guide.

You can view the book online, or print the information you need. To print, select Print
from the Books menu in IRIS InSight.

CD Installation

If the online manual has been removed from your system disk, you can reinstall it from
the O2+ IRIX operating system CD that comes with upgrades. Follow these steps:

1. Place the “IRIX 6.5” CD in the CD-ROM drive and double-click the CD-ROM icon
on your desktop. The Software Manager window appears. Click the Dismiss
button.

2. Click Customize Installation.

3. When the Open Additional Distribution dialog box appears, click Done.

4. From the Selected menu, select Unmark All.

5. From the Selected menu, select Find.

6. When the dialog box appears, enter Hardware Reference Guide, and click Search.
Software Manager highlights the Silicon Graphics O2+ Workstation Hardware
Reference Guide in its Software Inventory window.

7. Click the Install check box to select the book for installation, and click Start to begin
the installation. When the installation is complete, you see this message:
“Installation and removals were successful. You may continue with installation or
quit now.” Click OK.

8. Exit Software Manager by selecting Exit from the File menu.

9. To locate the online books, from the Toolchest select Help > Online Books > SGI
End User > Silicon Graphics O2+ Workstation Hardware Reference Guide.

10. If the book does not appear on the End User Bookshelf, you may have to update the
InSight database. In a shell window (to become a super-user) at the prompt, enter:

su

(Also enter the root password if you are prompted for it.)

11. To update the InSight database, enter:
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/usr/lib/infosearch/bin/booksAdmin -full -hwdi \
/usr/share/Insight/library/SGI_bookshelves

See “IRIS InSight Document Library” for instructions on viewing the book online.

Quick Answers

Quick Answers provides quick answers about tasks and tools that are part of your
system’s end-user software environment. You will find answers in the form of short
“how to” descriptions, links that launch applications, and pointers to the information
you need.

To use Quick Answers, from the Toolchest, select Help > Quick Answers.

Figure 1-12 Toolchest

InfoSearch

InfoSearch lets you search or browse all online information on your desktop.

To use Infosearch, from the Toolchest, select Help > Infosearch.

SGI Technical Publications Library

If you have access to the Internet, you can view most manuals on the SGI Technical
Publications Library at http://techpubs.sgi.com/library
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Turning the Workstation On or Off

To turn your workstation on or off, press the power button on the front (Figure 1-13). You
do not need to shut down the system software before turning it off.

Figure 1-13 Turning the Workstation On or Off

You can also turn the workstation off from the Toolchest menu on the desktop, as follows:

1. From the Toolchest, select System > System Shutdown. If you have a root
password set, you are prompted to enter it.

2. As the system shuts down, you see a cautionary message warning you that all
running applications are stopped and remote users are logged off. Click OK to shut
down the system.
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3. You see a message that says the system is shutting down, and then another message
telling you it is okay to power off. You can then press and release the power button
on the front of the workstation. Or, to shut down and restart the system without
powering off, click Restart.

Figure 1-14 Power Off Message

Setting Up the O2Cam Digital Video Camera

Note: The O2Cam is not a standard item with O2+ workstations.

The O2Cam color digital video camera captures images and video recordings. It has a
built-in microphone that points in the same direction as the lens. When you record audio,
speak toward the front of the camera, not toward the microphone on the side.

Note: If you want to place the camera face down for snapshots of documents or objects
on the desktop, a desktop camera stand is available. To order one, contact your local SGI
service provider.

For information on software media tools that you can use with the camera, see “About
the Digital Media Tools User’s Guide”.

For the camera’s technical specifications, see Hardware Central. (If your Web browser is
not loaded, it takes a few seconds to load.) Or, if you are viewing this on a remote server,
see “O2 Camera Technical Specifications” in Appendix A.



Setting Up the O2Cam Digital Video Camera

007-4486-001 17

Figure 1-15 shows how to connect the O2Cam to the workstation. Connect the camera
before turning on workstation so that the system recognizes the device.

Figure 1-15 Connecting the O2Cam to the Workstation
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Figure 1-16 shows the features of the O2Cam.

Figure 1-16 Front View of the O2Cam
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Figure 1-17 shows how to use the microphone on the camera.

Figure 1-17 Using the O2Cam’s Built-in Microphone
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Figure 1-18 shows how to set up the O2Cam on your monitor.

Figure 1-18 Setting Up the O2Cam on Your Monitor
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Securing the O2+ Workstation

Your workstation comes with a separate lockbar and a built-in slot for the Kensington
lock and cable. The lock and cable are not supplied by SGI. You purchase them separately
from a computer store. To secure the workstation, follow these steps:

1. Slide the feet of the lockbar into the holes on the rear of the workstation
(Figure 1-19).

Figure 1-19 Attaching the Lockbar to the Workstation
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2. Slide the lockbar to the right (Figure 1-20).

Figure 1-20 Sliding the Lockbar
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3. Insert the Kensington lock into the built-in security connector on the workstation.
Push the key into the lock and turn it (Figure 1-21).

Figure 1-21 Locking the O2+ Workstation

Removing the Lockbar

To remove the lockbar, unlock and remove the security connector. Then slide the lockbar
to the left and lift it out.

Locating Your Workstation’s Serial Number

At times you may need to know your workstation’s serial number. This section lists
several ways that you can find it. The serial number is the one that begins with 08.

Note: The illustrations show an RM7000class workstation. The serial number is in the
same locations on an R12000class workstation.
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• On the rear of the workstation, the serial number is located on the bottom right
beneath the audio visual module (Figure 1-22).

Figure 1-22 Locating the Serial Number On the Rear
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• Inside the workstation, the serial number is on the connector of the PCI tray, which
is attached to the system module (Figure 1-23). (To remove the system module, see
“Removing the System Module” in Chapter 2).

Caution: The small, printed circuit board beneath the PCI tray contains a host chip
with important system information such as the serial number. Do not mix PCI trays
between workstations. To check if your workstation has its original PCI tray,
compare the serial number on the rear of the workstation with the serial number on
the PCI tray connector. The serial numbers should be the same.

Figure 1-23 Locating the Serial Number Inside the Workstation

• If your system is running, from a shell window, type:

sysinfo -vv

• From the Toolchest, select System > System Manager > About This System.
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Chapter 2

2. Installing or Removing Memory and Option Boards

This chapter explains how to install or remove DIMMs (double in-line memory
modules), PCI option boards, or a digital display option board. The following topics are
covered:

• “Removing the System Module”

• “Installing Memory Modules”

• “Removing Memory Modules”

• “Installing a PCI Board in an RM7000class Workstation”

• “Removing a PCI Board in an RM7000class Workstation”

• “Installing a PCI Board in an R12000class Workstation”

• “Removing a PCI Board in an R12000class Workstation”

• “Installing an Option Board”

• “Removing an Option Board”

• “Reinstalling the System Module”

• “Verifying the Hardware Installation”

Caution: Boards and DIMMs are extremely sensitive to static electricity. Handle the
boards carefully, and wear the wrist strap while installing the hardware.

Removing the System Module

Before installing memory or option boards, you must follow these steps:

!



28 007-4486-001

Chapter 2: Installing or Removing Memory and Option Boards

Note: The illustrations show an O2+ RM7000class workstation. The process of installing
and removing the system module is the same for the O2+ R12000class workstation.

1. Turn off the workstation by pressing the power button on the front (Figure 2-1).

Figure 2-1 Turning Off the O2+ Workstation

2. Remove the power cable from the rear (Figure 2-2).

Caution: Always remove the power cable before removing the system module from
the workstation.

When you walk quickly across a room, or sit down or stand up, you build up a lot of
static electricity. To perform any of the hardware tasks on the system module, you
should stand in one place until you have completed the task.

!
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Figure 2-2 Disconnecting the Power Cables

3. The system module is on the left as you face the rear. Pull down the lever on the left
side of the module to release it (Figure 2-3).

Note: You do not need to remove the cables from the system module, if you are
careful when handling it. But you may find it easier to work if the cables are
removed.
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Figure 2-3 Pulling Down the Lever on the System Module

4. Slide the system module out of the chassis (Figure 2-4).
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Figure 2-4 Remove the System Module from the Chassis

5. Lay the system module on a clean, flat surface, such as your desktop (Figure 2-5).

Figure 2-5 Laying the System Module on a Flat Surface
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Now that you have removed the system module, you can perform the following
activities:

• To install memory, see “Installing Memory Modules.”

• To remove memory, see “Removing Memory Modules.”

• To install a PCI option board in an RM7000class workstation, see “Installing a PCI
Board in an RM7000class Workstation.”

• To remove a PCI option board in an RM7000class workstation, see “Removing a PCI
Board in an RM7000class Workstation.”

• To install a PCI option board in an R12000class workstation, see “Installing a PCI
Board in an R12000class Workstation.”

• To remove a PCI option board in an R12000class workstation, see “Removing the
PCI Tray in an R12000class Workstation.”

• To install a digital display option board, see “Installing an Option Board.”

• To remove a digital display option board, see “Removing an Option Board.”

Installing Memory Modules

To see a 3D animation of installing memory modules, see Hardware Central. When the
browser window opens, see “Hardware Overview” and then “Installing Memory
Modules.” (If your Web browser is not loaded, it takes a few seconds to load.) If you are
viewing this on a remote server, the 3D animation is not available.

Caution: The O2+ workstation uses DIMMs (Double Inline Memory Modules). DIMMs
are extremely sensitive to static electricity. Handle the modules carefully, and wear the
wrist strap while installing them.

Note: The illustrations show an O2+ RM7000class workstation. The process of installing
and removing memory modules is the same for the O2+ R12000class workstation. Also
note that DIMMs cannot be installed on earlier workstations that used SIMMs.

!
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To install memory modules, follow these steps:

1. If you have not already done so, remove the power cable, and remove the system
module from the chassis. See “Removing the System Module.”

2. Components on the system module are extremely sensitive to static electricity.
Before touching any of the components, ground yourself to a metal part of the
chassis, as follows:

• Unwrap the first two folds of the wrist strap and wrap the exposed adhesive
side firmly around your wrist.

• Unroll the rest of the strap and peel the liner from the copper foil at the opposite
end.

• Attach the copper foil to the PCI tray. Attach the wrist strap to your wrist and to
the PCI tray (Figure 2-6).

Figure 2-6 Attaching the Wrist Strap

3. Familiarize yourself with the memory (DIMM) banks (Figure 2-7) and (Figure 2-8).
There are four banks comprised of eight sockets, numbered 1 through 8. Two
sockets form a bank.

The minimum configuration has 256 MB of memory—one 128-MB module installed
in slot 1 and one 128-MB module installed in slot 2.
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Figure 2-7 Locating the DIMM Banks

Figure 2-8 Top View of the DIMM Banks

4. Read the following guidelines and then proceed to the next step.

• Slots 1 and 2 must always be populated.

• High-density DIMMs must always be installed in the lowest slots, that is, slots 1
and 2.

DIMM banks

8
7
6
5
4
3
2
1

B
an

ks
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• Install the DIMMs in groups of two, with DIMMs of the same capacity in each
bank of two. You cannot mix capacities in one bank.

• In a bank of two slots, both slots must have a DIMM or both slots must be
empty (except for slots 1 and 2, which must always be populated). For example,
you can install a 128-MB module in slot 3, a 128-MB module in slot 4, a 64-MB
module in slot 5 and a 64-MB module in slot 6. But you cannot install a 128-MB
module in slot 3 and a 64-MB module in slot 4.

Note: If you need to remove a DIMM, see “Removing Memory Modules.”

5. Install the DIMMs consecutively in groups of two, beginning with the lowest open
slot (Figure 2-9), as follows:

• Hold the DIMM over the socket without tilting it.

• Lower the DIMM, pushing it straight down into the socket gently but firmly.
You hear a click as it is seated and the latches on each side of the module snap
up.

Figure 2-9 Installing the Memory Modules

6. Check the DIMMs visually to make sure they are installed correctly (Figure 2-10), as
follows:

• The tops of the DIMMs of the same capacity should be even.
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• The DIMMs should all be absolutely vertical (no leaning).

• The latches on the sides should fit snugly against each DIMM.

Figure 2-10 Checking the DIMM Installation

7. Remove the wrist strap and follow the steps in “Reinstalling the System Module.”

Removing Memory Modules

To remove memory modules, follow these steps:

1. If you have not already done so, remove the power cable, and remove the system
module from the chassis. See “Removing the System Module.”

2. Before touching any of the components, ground yourself to a metal part of the
chassis, as follows:

• Unwrap the first two folds of the wrist strap and wrap the exposed adhesive
side firmly around your wrist.

• Unroll the rest of the strap and peel the liner from the copper foil at the opposite
end.

• Attach the copper foil to the PCI tray. Attach the wrist strap to your wrist and to
the PCI tray (Figure 2-11).
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Figure 2-11 Attaching the Wrist Strap

3. Remove the DIMM by pushing down the latches on both sides to release it. Pick up
the DIMM and set it aside (Figure 2-12).

Figure 2-12 Removing the Memory Module

4. If you want to install memory modules, see “Installing Memory Modules.” If not,
remove the wrist strap and follow the steps in “Reinstalling the System Module.”
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Installing a PCI Board in an RM7000class Workstation

To install a PCI board in an RM7000class workstation, follow these steps:

Note: Check the documentation and software release notes that come with the PCI board
for instructions on installing the software. The software may include online software
guides.

1. If you have not already done so, remove the power cable, and remove the system
module from the chassis. (See “Removing the System Module.”)

Caution: The small, printed circuit board beneath the PCI tray contains a host chip
with important system information such as the serial number. Do not mix PCI trays
between workstations. If you remove the PCI tray, always replace it, or the
workstation will not operate correctly.

2. Release the PCI tray by pushing up the lever on the side (Figure 2-13). The tray pops
up.

Figure 2-13 Releasing the PCI Tray

3. Push down slightly on the rear of the PCI tray and remove it from the system
module (Figure 2-14).

!
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Figure 2-14 Removing the PCI Tray

4. Hold the PCI tray with one hand and remove the screw and the filler panel from the
tray (Figure 2-15). Keep the panel and screw. If you later remove the PCI board and
do not replace it, you must reinstall the filler panel.
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Figure 2-15 Removing the Screw and Filler Panel

5. Slide the PCI board into the tray and push the PCI connector firmly into the slot
(Figure 2-16). Make sure it is completely seated. You should hear a click as it is
seated. You may have to use some pressure.

Note: PCI boards with extra long I/O connectors may be difficult to install. In this
case, slide the board into the tray at an angle, inserting the side with the I/O
connector first, and then rotate in the other side.

6. Replace the screw and tighten it (Figure 2-16).
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Figure 2-16 Installing the PCI Board

7. Push the lever to return it to its starting position (Figure 2-17).
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Figure 2-17 Returning the Lever to Its Starting Position

8. Replace the tray in the system module (Figure 2-18), as follows:

• Engage the hinge on the PCI tray in the slot on the system module.

• Lower the tray, as you push toward the back of the system module.

• Look from the side and align the gold-colored PCI edge connector with the slot
on the system board.
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Figure 2-18 Replacing the PCI Tray in the System Module

9. Push the tray down firmly until it is completely seated. You hear a click as it seats.
Check that the lever returns to its starting position (Figure 2-19).

Caution: If the PCI tray is not completely seated, the system module will not slide
back into the chassis.!
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Figure 2-19 PCI Tray Seated Correctly

Note: If the option board you installed comes with a cable, remember to connect the
cable to the option board’s external port after you reinstall the system module.

10. Follow the steps in “Reinstalling the System Module.”

Removing a PCI Board in an RM7000class Workstation

To remove a PCI board in an RM7000class workstation, follow these steps:

1. If you have not already done so, remove the power cable and remove the system
module from the chassis. (See “Removing the System Module.”)

2. Release the PCI tray by pushing up the lever on the side (Figure 2-20). The tray pops
up.
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Figure 2-20 Releasing the PCI Tray

3. Push down slightly on the rear of the PCI tray and remove it from the system
module (Figure 2-21).

Figure 2-21 Removing the PCI Tray

4. Remove the screw that secures the board (Figure 2-22). Disconnect the PCI board
and slide it out of the tray. (It may be a little difficult to remove.)
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Note: If the PCI board has an extra long I/O connector, pivot up the side of the board
without the long I/O connector first. Then slide out the side with the I/O connector.

Figure 2-22 Removing the Screw and the PCI Board

5. If you want to install another PCI board, see “Installing a PCI Board in an
RM7000class Workstation”. If not, replace the filler panel and screw (Figure 2-23).
(You removed the panel and screw when you installed the board.)
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Figure 2-23 Replacing the Filler Panel and Screw on the PCI Tray

6. Follow the steps in “Reinstalling the System Module.”

Installing a PCI Board in an R12000class Workstation

To install a PCI board in an R12000class workstation, follow these steps:

Note: Check the documentation and software release notes that comes with the PCI
board for instructions on installing the software. The software may include online
software guides.
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1. If you have not already done so, remove the power cable, and remove the system
module from the chassis. (See “Removing the System Module.”)

Caution: The small, printed circuit board beneath the PCI tray contains a host chip
with important system information such as the serial number. Do not mix PCI trays
between workstations. If you remove the PCI tray, always replace it, or the
workstation will not operate correctly.

2. Remove the screw and filler panel from the PCI tray.

Keep the panel. If you later remove the PCI board and do not replace it, you must
reinstall the filler panel and screw (Figure 2-24).

Figure 2-24 Removing the Screw and Filler Panel

Note: PCI boards with extra long I/O connectors may be difficult to install. In this case,
slide the board into the tray at an angle, inserting the side with the I/O connector first,
and then rotate in the other side.

3. Install the PCI board by sliding the PCI board into the tray and pushing the PCI
connector firmly into the slot. Make sure it is completely seated (Figure 2-25). You
may need to use some pressure to seat it all the way.

!
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Figure 2-25 Installing the PCI Board on the R12000class Workstation

4. Insert and tighten the screw that secures the PCI board (Figure 2-26).

Figure 2-26 Securing the PCI Board

5. Follow the steps in “Reinstalling the System Module.”
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Removing a PCI Board in an R12000class Workstation

To remove a PCI board in an R12000class workstation, follow these steps:

1. If you have not already done so, remove the power cable and remove the system
module from the chassis. (See “Removing the System Module.”)

2. Remove the screw that secures the PCI board (Figure 2-27).

3. Remove any external cables connected to the PCI board.

4. Disconnect the PCI board from the connector and slide it out of the tray. (It may be a
little difficult to remove.)

Note: If the PCI board has an extra long I/O connector, slide out the side opposite the
long I/O connector first. Then remove the side with the I/O connector.

Figure 2-27 Removing the Screw That Secures the PCI Board

5. If you want to install another PCI board, see “Installing a PCI Board in an
R12000class Workstation.” If not, replace the screw and filler panel (Figure 2-28).
(You removed the screw and panel when you first installed the board.)
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Figure 2-28 Replacing the Filler Panel and Screw

6. Follow the steps in “Reinstalling the System Module.”

Installing an Option Board

The figures in this section show an option board similar to the Dual Channel Display
Option Board (DCD), which enables two monitors to be plugged into an O2+
workstation (Figure 2-29).

The board you want to install may look different, but the installation steps are the same.
Review any documentation that comes with the option board.

Caution: Option boards are extremely sensitive to static electricity. Handle it carefully,
and wear the wrist strap while installing the board.!
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Figure 2-29 Option Board

The slot for the display option is on the system module.

To install an option board, follow these steps:

1. If you have not already done so, remove the power cable, and remove the system
module from the chassis. (See “Removing the System Module.”)

2. Remove the PCI tray as follows:

• If you have an RM7000class workstation, see “Removing a PCI Board in an
RM7000class Workstation.”

• If you have an R12000class workstation, see “Removing the PCI Tray in an
R12000class Workstation.”

Note: Most of the illustrations in this section show an RM7000class workstation. The
installation process is the same for an R12000class workstation.

3. Before touching any of the components, ground yourself to a metal part of the
chassis with a wrist strap (Figure 2-30), as follows:

• Wrap the first two folds of the strap around your wrist.
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• Peel the liner from the copper foil at the opposite end.

• Attach the copper foil to the metal part of the chassis.

Figure 2-30 Attaching the Wrist Strap

4. If there is a filler panel covering the I/O slot, remove the filler panel as follows:

• Use a Phillips screwdriver to remove the two screws that hold it (Figure 2-31).

• Push the filler panel inward.

• Remove the filler panel and save it. In the event that you remove the option
board and do not replace it, you must reinstall the panel.
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Figure 2-31 Removing the I/O Filler Panel

5. Maneuver the board until its I/O connector is opposite the open slot in the rear of
the chassis and it is parallel to the system board (Figure 2-32). You may find this
installation difficult, especially on an R12000class workstation, because there is
limited space in which to work. Figure 2-32, Figure 2-33, and Figure 2-34 show an
R12000class O2+ workstation.
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Figure 2-32 Positioning the Option Board

6. Push the left side of the board toward the rear and then to the right side, until the
connector underneath is aligned over the socket on the system board. Remember to
keep the board parallel to the system board as you align it (Figure 2-33).

Figure 2-33 Aligning the Option Board

1
2
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7. Push the board down into the socket firmly until it clicks and the connectors are
completely seated. Look from the side as shown in Figure 2-34.

Figure 2-34 Seating the Option Board Viewed from the Side

8. Insert and tighten two screws in the locations shown (Figure 2-35).

Figure 2-35 Installing the Two Screws
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9. Remove the wrist strap.

10. Reinstall the PCI tray as follows:

• If you have an RM7000class workstation, see “Reinstalling the PCI Tray in an
RM7000class Workstation.”

• If you have an R12000class workstation, see “Reinstalling the PCI Tray in an
R12000class Workstation.”

Removing the PCI Tray in an RM7000class Workstation

To remove the PCI tray in an RM7000class workstation, follow these steps:

1. Push up the lever on the side of the PCI tray to release it (Figure 2-36). The tray pops
up.

Figure 2-36 Releasing the PCI Tray

2. Push down slightly on the rear of the PCI tray and remove it from the system
module (Figure 2-37). Do not remove the PCI board from the tray, if one is installed.
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Figure 2-37 Removing the PCI Tray

3. Follow the steps in “Installing an Option Board.”

Removing the PCI Tray in an R12000class Workstation

To remove the PCI tray in an R12000class workstation, follow these steps:

1. You must remove the plastic faceplate of the system module as follows:

• Use a Phillips screwdriver to remove five screws in the rear and two screws on
the underside, in the locations shown (Figure 2-38). Keep the two screws from
the underside separate. When reinstalling the faceplate you must use the same
screws.

Caution: On the underside, remove only two screws. Do not remove the third
screw that attaches the lever to the faceplate.!
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Figure 2-38 Removing the Screws from the Faceplate

• Remove the faceplate by grasping it where the plastic comes to a “V” and
pulling it outward. (See Figure 2-39.) The filler panel covering the I/O port falls
away as you remove the faceplate.

Figure 2-39 Removing the Faceplate from the System Module
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2. Remove the PCI tray from the system module, as follows. If a PCI board is installed in
the tray, do not remove it from the tray. However, you need to disconnect any cables
attached to the PCI board.

• Insert a screwdriver in the small opening shown (Figure 2-40). Use a twisting
motion first to release the PCI connector from the slot on the system module.
Then use an up and down motion to release the PCI tray.

• Pull the PCI tray straight up to remove it and set it aside.

Figure 2-40 Removing the PCI Tray from the R12000class System Module

3. Follow the steps in “Installing an Option Board.”

Reinstalling the PCI Tray in an RM7000class Workstation

To reinstall the PCI tray in an RM7000class workstation, follow these steps:
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1. Push the lever to return it to its starting position (Figure 2-41).

Figure 2-41 Returning the Lever to Its Starting Position

2. Reinstall the PCI tray in the system module (Figure 2-42), as follows:

• Engage the hinge on the PCI tray in the slot on the system module.

• Lower the tray as you push toward the back of the module.

• Align the gold-colored PCI edge connector with the slot on the system board.
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Figure 2-42 Replacing the PCI Tray in the System Module

3. Push the tray down firmly until it is completely seated. You hear a click as it seats
(Figure 2-43).

Caution: If the PCI tray is not completely seated, the system module will not slide
back into the chassis.!
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Figure 2-43 PCI Tray Seated Correctly

4. Follow the steps in “Reinstalling the System Module.”

Reinstalling the PCI Tray in an R12000class Workstation

To reinstall the PCI tray in an R12000class workstation, follow these steps:

1. Replace the PCI tray in the system module, as follows:

• Lower the PCI tray, engaging it on the tab on the side of the system module
(Figure 2-44).

• Insert the PCI connector beneath the tray into the slot on the system module.

• Once the connector is aligned, push down firmly until it is completely seated.

Note: If the PCI tray is not completely seated, the system module will not slide back
into the chassis.
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Figure 2-44 Replacing the R12000class PCI Tray in the System Module

2. Replace the faceplate by sliding it onto the system module, while at the same time
lifting the plastic at the “V” to snap it in place. When properly seated, the underside
of the faceplate is flush to the module and the screw holes are aligned (Figure 2-45).
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Figure 2-45 Replacing the Faceplate

3. Align the screw holes on the faceplate with the screw holes on the system module.
Use a Phillips screwdriver to insert and tighten two screws on the underside in the
locations shown (Figure 2-46).

Figure 2-46 Replacing Two Screws on the Faceplate
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4. Use a Phillips screwdriver to insert and tighten five screws on the rear in the
locations shown (Figure 2-47).

Figure 2-47 Replacing Five Screws on the Faceplate

5. Follow the steps in “Reinstalling the System Module.”

Removing an Option Board

To remove an option board, follow these steps:

1. If you have not already done so, remove the power cable, and remove the system
module from the chassis. (See “Removing the System Module.”)

2. To reach the option board, you must first remove the PCI tray, as follows:

• If you have an RM7000class workstation, see “Removing a PCI Board in an
RM7000class Workstation.”

• If you have an R12000class workstation, see “Removing the PCI Tray in an
R12000class Workstation.”

3. Before touching any of the components, ground yourself to a metal part of the
chassis with a wrist strap (Figure 2-48), as follows:

• Wrap the first two folds of the strap around your wrist.
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• Peel the liner from the copper foil at the opposite end.

• Attach the copper foil to the metal part of the chassis.

Figure 2-48 Attaching the Wrist Strap

4. Grasp the board on either side and gently rock it out until it disconnects from the
slot on the system board (Figure 2-49). Do not exaggerate the rocking motion,
because you should not bend the pins. You may find this difficult because there is
limited space in which to work.
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Figure 2-49 Removing the Option Board

5. If you want to install another option board, see “Installing an Option Board.” If not,
replace the filler panel that you removed when you installed the first option board.

6. Remove the wrist strap.

7. Reinstall the PCI tray, as follows:

• If you have an RM7000class workstation, see “Reinstalling the PCI Tray in an
RM7000class Workstation.”

• If you have an R12000class workstation, see “Reinstalling the PCI Tray in an
R12000class Workstation.”
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Reinstalling the System Module

To reinstall the system module, follow these steps:

Note: The illustrations show an RM7000class workstation. The process of installing the
system module is the same for an R12000class workstation.

1. Return the system module to its upright position (Figure 2-50).

Figure 2-50 Returning the System Module to Its Upright Position

2. Slide the system module into the chassis until the lever engages (Figure 2-51).
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Figure 2-51 Reinstalling the System Module in the Chassis

3. Push the lever up to lock the module in place (Figure 2-52). If installed correctly, the
lever is all the way up and the system module is flush with the system drive module
and other modules.
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Figure 2-52 Securing the System Module in Place

4. Remove the wrist strap from the chassis.

5. Reconnect the power cable and any other cables you removed (Figure 2-53).

6. If you installed an option board that has a cable, connect the cable to the I/O port on
the board you installed.
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Figure 2-53 Connecting the Power Cable

7. Turn on the workstation by pressing the power button on the front (Figure 2-54).

8. If you have just installed memory modules or an option board, follow the steps in
“Verifying the Hardware Installation.”
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Figure 2-54 Turning On the Workstation

Verifying the Hardware Installation

Once you have installed memory modules or an option board, you should verify that the
system recognizes the new hardware, as follows:

1. Log in to your account.

2. From the Toolchest (Figure 2-55), select System > System Manager > About This
System.

Figure 2-55 The Toolchest
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3. If you installed memory, look under the Hardware menu. Check the amount of
memory shown. It should equal the total amount that you installed.

For example, if you had 32 MB of memory when you started and you installed
another 64 MB, the total shown should be 96 MB.

If the system does not show the total amount of memory you installed, turn off the
workstation, remove the power cable, remove the system module, and make sure
all the DIMMs are installed correctly.

4. If you installed a PCI option board, from a shell window, enter:
hinv

This shows the hardware inventory for your workstation. Look for a line describing
the board you installed. For some option boards, the software must be installed
before the board is shown.

If it is now shown, turn off the workstation, and review the installation steps again
to make sure the board is seated correctly. (See “Installing a PCI Board in an
RM7000class Workstation,” or “Installing a PCI Board in an R12000class
Workstation.”)
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Chapter 3

3. Installing or Removing Peripherals

This chapter tells you how to install or remove a second hard disk drive in your O2+
workstation and how to connect external peripherals. The following topics are covered:

• “Installing a Second Internal Hard Drive in an RM7000class Workstation”

• “Removing the Second Internal Hard Drive in an RM7000class workstation”

• “Connecting External SCSI Devices”

• “Connecting Serial Devices”

• “Connecting Audio and Video Devices”

Installing a Second Internal Hard Drive in an RM7000class Workstation

Note: The optional drive bay is not available on O2+ R12000class workstations.

After you have installed the second hard disk, see “Setting Up a New Hard Disk” in the
online Personal System Administration Guide for information on how to manage your disk
space.
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1. Turn off the workstation by pressing the power button on the front (Figure 3-1).

Figure 3-1 Turning Off the Workstation

2. Locate the optional drive bay (Figure 3-2) where you will install the second internal
hard drive. The drive bay is covered with a blank panel that you must remove.
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Figure 3-2 Locating the Optional Drive Bay

3. To remove the panel over the optional drive bay, you must first remove the
audio-visual module located on the far right as you face the rear of the workstation.
First, remove the power cable from the rear and any audio-visual cables that are
connected to the side panel (Figure 3-3).
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Figure 3-3 Disconnecting the Power Cable and Other Cables

4. Release the audio-visual module by pulling down the lever (Figure 3-4).
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Figure 3-4 Releasing the Audio-visual Module

5. Slide the audio-visual module out of the chassis and place it carefully on a clean,
flat, antistatic surface, such as your desktop (Figure 3-5).
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Figure 3-5 Sliding Out the Audio-visual Module

6. With your fingers, pry off the front panel that covers the optional drive bay
(Figure 3-6).

Save the panel. If you remove the second drive and do not replace it, you must
reinstall the panel.
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Figure 3-6 Removing the Panel from the Optional Drive bay

7. Slide the second hard drive into the optional drive bay until the lever engages
(Figure 3-7).

Note: You do not need to set the SCSI address on the second drive. The optional
drive bay on the O2+ workstation is preconfigured.
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Figure 3-7 Installing the Second Hard Drive Module

8. Push the lever up to lock the drive module in place (Figure 3-8).



Installing a Second Internal Hard Drive in an RM7000class Workstation

007-4486-001 83

Figure 3-8 Securing the Second Hard Drive Module

9. Slide the audio-visual module back into the bay on the far right of the chassis
(Figure 3-9).
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Figure 3-9 Reinstalling the Audio-visual Module in the Chassis

10. Push the lever up to lock the audio-visual module in place (Figure 3-10).
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Figure 3-10 Securing the Audio-visual Module

11. Reconnect the power cable to the rear of the workstation. Reconnect any audio and
video cables that you removed from the side panel of the workstation (Figure 3-11).
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Figure 3-11 Connecting the Power Cable and Other Cables

12. Turn on the workstation by pressing the power button on the front (Figure 3-12).

Figure 3-12 Turning On the Workstation
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13. To check that the system recognizes the new hard disk drive, from the Toolchest
select System > System Manager > Hardware and Devices > Disk Manager. The
system disk and the second disk are displayed.

For information on how to manage your disk space, see “Setting Up a New Hard Disk”
in the online Personal System Administration Guide.

Removing the Second Internal Hard Drive in an RM7000class workstation

Before removing the second drive, read “Remove a Disk from the System” in the online
Personal System Administration Guide to find out how to unmount the filesystem(s) on the
drive you are removing.

Note: If you do not unmount the necessary filesystem(s) before removing the disk, you
will not compromise any data, but your system may start more slowly as it spends time
looking for missing filesystems.

1. Turn off the workstation by pressing the power button on the front (Figure 3-13).

Figure 3-13 Turning Off the Workstation



88 007-4486-001

Chapter 3: Installing or Removing Peripherals

2. Remove the power cable from the rear.

3. The second hard disk is in the optional drive bay—the one between the system
drive and the audio-visual module. (The R12000class O2+ does not have an optional
drive bay.) Pull down the lever on the left side of the optional drive module to
release it (Figure 3-14).

Figure 3-14 Releasing the Optional Drive Module

4. Pull the drive module out of the chassis (Figure 3-15).
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Figure 3-15 Sliding the Second Hard Drive out of the Chassis

5. If you are installing another optional hard drive, see steps 7 and 8 of “Installing a
Second Internal Hard Drive in an RM7000class Workstation.” Otherwise, replace
the blank filler panel over the open drive slot (Figure 3-16). (You removed the panel
when you first installed the drive.)
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Figure 3-16 Replacing the Filler Panel

6. Reconnect the power cable to the rear of the workstation (Figure 3-17). Reconnect
any audio-visual cables that you removed from the side or rear panel of the
workstation.
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Figure 3-17 Reconnecting the Cables

Connecting External SCSI Devices

The following information is covered in this section:

• “Choosing a SCSI Address for the External Device”

• “Setting the SCSI Address on the External Device”

• “Connecting One External SCSI Device”

• “Connecting More Than One External SCSI Device”

You can connect one or more external SCSI devices in a daisy-chain to the O2+
single-ended, wide SCSI bus if the maximum combined cable length of all external SCSI
cables does not exceed three meters. You can connect either 16-bit wide (68-pin) or 8-bit
narrow (50-pin) SCSI devices, but you should follow the guidelines about where to place
the devices on the chain, in “Connecting More Than One External SCSI Device.”

Each device has a unique SCSI address and is connected to the other devices in a chain,
with the first device connected to the SCSI port on the rear of the workstation. The last
device on the daisy-chain must be terminated with an active SCSI terminator.
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Caution: For external SCSI devices to operate reliably, the maximum combined cable
length of all external SCSI cables cannot exceed three meters. Use the cable and active
SCSI terminator that came with the device. If you are using other types of cables or
terminators, data loss can result.

External SCSI devices include the following drives: 1/4-inch cartridge tape, digital audio
tape, digital linear tape, optical disk, removable cartridge disk, and hard disk. SCSI
scanners are also supported.

Choosing a SCSI Address for the External Device

Each device on the daisy-chain needs a unique numeric SCSI address to distinguish it
from other devices. The O2+ workstation has two built-in SCSI buses. The system drive,
the optional hard drive (if installed), and the internal CD-ROM drive are on the internal
SCSI bus.

All external devices are on the external SCSI bus. You can connect as many as 15 wide
external devices or 7 narrow external devices, as long as the cable length limitation is not
exceeded.

If you have one or more external devices connected to your system, and you want to add
another device, check which addresses are assigned to the existing devices and then
choose another number. Follow these steps:

1. From the Toolchest, select System > System Manager > About This System.

2. Pick an unassigned number between 1 and 15 for the device that you are adding.

If the SCSI devices and their addresses do not appear under “About This System,” type
hinv in a shell window.

!
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Setting the SCSI Address on the External Device

Now that you have chosen a SCSI address, you need to set the address manually on the
device that you will install. Most SCSI devices have a push-button switch or dial. The
switch or dial is usually located on the rear or bottom of the device. You may need a small
screwdriver or pen tip to set the dial or push the buttons. See the following:

• If you will install the first external SCSI device, see “Connecting One External SCSI
Device.”

• If you will install additional SCSI devices, see “Connecting More Than One External
SCSI Device.”

Connecting One External SCSI Device

To connect one external SCSI device, follow these steps:

1. Turn off the workstation (Figure 3-18).

Figure 3-18 Turning Off the Workstation

2. Choose the appropriate cable, as follows:



94 007-4486-001

Chapter 3: Installing or Removing Peripherals

• For a SCSI device with a wide 68-pin connector, use a 68-pin SCSI-3 to 68-pin
SCSI-3 cable (0.75 meter).

• For a SCSI device with a narrow 50-pin connector, use a 68-pin SCSI-3 to 50-pin
Centronics SCSI-2 cable (0.75 meter).

3. Connect the SCSI cable to the SCSI port on the rear of the workstation and to the
SCSI connector on the back of the device. If there are thumbscrews on either side of
the connectors, tighten them (Figure 3-19).

Note: The illustration shows an RM7000class workstation. The process of connecting
an external SCSI device is the same on an R12000class workstation.

Figure 3-19 Connecting One External Device to the Workstation

4. Connect the power cable to the SCSI device and to a working electrical outlet.

5. Connect the active SCSI terminator to the device.
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6. Turn on the device, and then turn on the workstation. You must turn on the
equipment in this order, so that the workstation recognizes the device.

7. To check that the system recognizes the new SCSI device, from the Toolchest, select
System > System Manager > About This System. External SCSI devices are shown
here.

For more information, see “Hardware and Devices” in Personal System Administration
Guide.

Connecting More Than One External SCSI Device

Read the following guidelines before you begin the process of connecting the SCSI
device.

• You can connect both 16-bit wide (68-pin) and 8-bit narrow (50-pin) SCSI devices to
the workstation, but you must install the wide devices as a group closest to the
workstation. Place the narrow devices at the end of the daisy-chain.

• If the first external device is a 68-pin device, you can daisy-chain a 50-pin device to
it, but you cannot then daisy-chain a 68-pin device to the 50-pin device.

• You can use a 68-pin device as the first device, a 68-pin device as the second device,
and a 50-pin device as the third device.

• On an O2+ workstation, wide and narrow SCSI devices can coexist on the same bus
because the SGI 68-pin to 50-pin cable includes an active terminator for the extra
data lines in the 68-pin connector.

In summary, the accepted and incorrect configurations are as follows:

Accepted configurations:
68-pin to 50-pin
68-pin to 68-pin to 50-pin

Incorrect configuration:
68-pin to 50-pin to 68-pin

To connect more that one external SCSI device, follow these steps:
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1. Turn off the workstation (Figure 3-20).

Figure 3-20 Turning Off the Workstation

2. Read the instructions in “Choosing a SCSI Address for the External Device” and
“Setting the SCSI Address on the External Device.” Then return here.

3. Remove the active SCSI terminator from the first device on the daisy-chain.

4. Choose the appropriate SCSI cable, as follows:

For the first external device, choose as follows:

• For the SCSI device with a wide 68-pin connector, use a 68-pin SCSI-3 to 68-pin
SCSI-3 cable (0.75 meter).

• For the SCSI device with a narrow 50-pin connector, use a 68-pin SCSI-3 to
50-pin Centronics SCSI-2 cable (0.75 meter).

For the second and all other devices on the daisy-chain, choose as follows:

• For the SCSI device with a wide 68-pin connector, use a 68-pin SCSI-3 to 68-pin
SCSI-3 cable (0.25 meter).

• For the SCSI device with a narrow 50-pin connector, use a 50-pin Centronics
SCSI-2 to 50-pin Centronics SCSI-2 cable (.5 meter).
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5. Link the devices in a daisy-chain (Figure 3-21), as follows:

First device: Connect the SCSI cable to the device and to the workstation. If there
are thumbscrews on either side of the connectors, tighten them.

Second and all other devices: Connect the SCSI cable to the connector on the back
of each device. If there are thumbscrews on either side of the connectors, tighten
them.

Note: The illustration shows an RM7000class workstation. The process of connecting
external SCSI devices is the same on an R12000class workstation.

6. Connect a power cable to each SCSI device and to a working electrical outlet.

7. Connect the active SCSI terminator to only the last device on the daisy-chain.

8. Turn on each device, and then turn on the workstation. You must turn on the
devices in this order, so that the workstation recognizes the devices.

9. To check that the system recognizes the new SCSI devices, from the Toolchest select
System > System Manager > About This System. External SCSI devices are shown
here.
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Figure 3-21 Connecting More Than One Device in a Daisy-chain

For more information, see “Hardware and Devices” in the Personal System Administration
Guide.
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Connecting Serial Devices

Examples of serial devices you can connect to your O2+ workstation include: dial and
button boxes, digitizer tablets, console terminals, modems, optical mice, MIDI (Musical
Instrument Digital Interface) devices, Spaceball, and the Logitech Magellan 3D input
device.

Figure 3-22 shows the location of the serial ports on the rear of the workstation. The serial
ports are labeled 1 and 2 and are DB9 connectors. To view the serial port cable pinouts,
and for information on Silicon Graphics serial cables and converters, see Hardware
Central. (If your Web browser is not loaded, it takes a few seconds to load.) Or, if you are
viewing this on a remote server, see Appendix A, “Technical Specifications”.

Note: The illustration shows an RM7000class workstation. The process of connecting
serial devices is the same on an R12000class workstation.

Figure 3-22 Locating the Serial Ports

Serial ports
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1. Before connecting the device, use the Serial Device Manager to configure the serial
port you will use. From the Toolchest select System > System Manager > Hardware
and Devices > Serial Devices Manager.

2. Connect one end of the serial cable to the serial port (Figure 3-22). Connect the other
end to the serial device, as follows:

• If connecting a console terminal, attach it to serial connector 1 only.

• If connecting a dial and button box, you need to attach a female-to-female
adapter to the serial cable before connecting it to the workstation.

• If connecting a Macintosh compatible MIDI (Musical Instrument Digital
Interface) equipment, you need the Silicon Graphics MIDI converter. To
purchase one, contact your Silicon Graphics service provider.

Connecting Audio and Video Devices

Figure 3-23 shows the location of the audio and video ports on the workstation.

Note: The illustration shows an RM7000class workstation. The process of connecting
audio and video devices is the same on an R12000class workstation.
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Figure 3-23 Audio and Video Ports

For cable pinout information, see Hardware Central. (If your Web browser is not loaded,
it takes a few seconds to load.) Or, if you are viewing this on a remote server, see “Cable
Pinout Assignments” in Appendix A.

For information on digital audio and video tools, see Digital Media Tools User’s Guide, or
in the Help menus of digital media applications.

Connecting Audio Devices

The side panel audio ports support:

• Stereo line level in and out (RCA plugs)

• Stereo headphone out (3.5 mm phono)
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• Mono microphone in (3.5 mm phono)

The rear panel audio ports support:

• Stereo line out (3.5-mm phono)

• Embedded microphone in the O2Cam

Connecting Video Devices

Note: The video option is not available on all models.

Your workstation can send and receive analog composite video (RCA) and S-video
(MiniDIN) signals. In addition, the digital camera port provides a digital video input and
output signal. The signal is proprietary to SGI and is similar to the parallel D-1 signal
used in professional video applications.

The analog S-video and analog composite video ports accept most consumer and
industrial-grade video equipment.

For cable pinout information, see Hardware Central. (If your Web browser is not loaded,
it takes a few seconds to load.) Or, if you are viewing this on a remote server, see “Cable
Pinout Assignments” in Appendix A.

Note: Connect the O2Cam before turning on the workstation, so that the system
recognizes the camera.
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Chapter 4

4. Troubleshooting

This chapter describes how to diagnose hardware problems. It also includes information
on running diagnostics. The following topics are covered:

• “Diagnosing the Problem”

• “Running Diagnostic Tests”

• “Recovering from System Crash”

• “Disabling the System Maintenance Password”

• “Service and Support Information”

Diagnosing the Problem

If you suspect a problem with your hardware, use the flowchart (Figure 4-1 and
Figure 4-2) to isolate and solve the problem. See also “Running Diagnostic Tests.”
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Figure 4-1 Diagnostic Flow Chart #1
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Figure 4-2 Diagnostic Flow Chart #2
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Running Diagnostic Tests

Figure 4-3 System Diagnostic Tests

Three types of software diagnostics tests are provided on the O2+ workstation, described
in the following subsections:

• “Power-on Tests”

• “Confidence Tests”

• “IDE Tests”

Power-on Tests

Power-on tests run automatically on the major hardware components of the workstation
each time it is turned on. If the tests find a faulty part, the LED on the front of the system
will be red and there will probably be an error message. See also “Diagnosing the
Problem.”
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Confidence Tests

There are confidence tests for the mouse, keyboard, monitor, audio subsystem, external
SCSI devices (excluding hard disks), Presenter, and ISDN connection.

To run the confidence tests, from the Toolchest, select System > Confidence Tests.
Double-click the icon for the part that you believe is faulty, and follow the online
instructions.

IDE Tests

The Interactive Diagnostic Environment (IDE) tests are more comprehensive than the
confidence tests, and take longer (as long as 30-45 minutes) to run. Follow these steps:

1. Turn off the workstation, wait a few seconds, and then turn it on again.

2. When you see the System Startup message (Figure 4-4), click Stop for Maintenance,
or press Esc.

Figure 4-4 System Startup Message

3. When you see the System Maintenance menu, select Run Diagnostics, or type 3 on
the keyboard.

Tip: You can stop the tests at any time by pressing Esc.

Note: If you cannot reach the System Maintenance menu, your system is faulty. If
you cannot run the diagnostics, you may have a faulty disk drive or another
problem. Contact your service provider.

4. When the tests are complete, you see a message with the results of the tests. Press
Enter and then Esc to return to the System Maintenance menu, from which you can
restart the system.
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Recovering from System Crash

In most cases, your system will recover from a system crash automatically if you reboot
the system. If, however, you have lost data on your system disk, and you cannot
communicate with your system using the mouse or keyboard, or over the network,
follow these instructions. The instructions assume that you have a backup tape of your
system that has been made using the System Manager backup tool, or with the
/usr/sbin/Backup script. You also need a CD with your current IRIX operating system
level. If you are recovering data from a tape on a remote tape device, you need to know
the hostname, tape device name, and IP address of the remote system.

1. Use a pen tip or a large, straightened paper clip to press the Reset button located on
the front panel (Figure 4-5).

Figure 4-5 Pressing the Reset Button

2. When you see the System Startup message (Figure 4-6), click Stop for Maintenance
or press Esc.
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Figure 4-6 System Startup Message

3. From the System Maintenance menu, select Recover System, or type 4 on the
keyboard. The System Recovery menu appears (Figure 4-7).

Figure 4-7 System Recovery Menu

4. If you have the IRIX CD and a CD-ROM drive connected to your system, click Local
CD-ROM, and then click Accept. Insert the CD when prompted. The system takes
five minutes or more to copy the information.

If you do not have a CD-ROM drive, use a drive that is connected to another system
on the network. Click Remote Directory.

5. When a message appears asking you for the remote hostname, type the system’s
name, a colon (:), and the full pathname of the CD-ROM drive, followed by /dist.

For example, to access a CD-ROM drive on the “mars” system, you type:

mars:/CDROM/dist
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After everything is copied from the CD to the system disk, you can restore your
data from a recent full backup tape. The backup must be one that has been made
using the System Manager backup tool, or with the /usr/sbin/Backup script.

Tip: If you need to check something on your system during the restore process, you
can get a shell prompt by typing sh at most question prompts.

6. If you have a local tape device, you would answer the following message:

Restore will be from <tapename> OK? ([Y]es, [N]o): [Y]

tapename is the name of the local tape device.

7. If you have a remote (network) tape device, when no tape device is found, or when
you answered “No” to the question in the previous step, you would answer the
following message:

Remote or local restore ([r]emote, [l]ocal):

Select an answer as follows:

• Select “remote,” if you want to restore from the network, and you know the
hostname, tape device name, and IP address of the remote system. You also
need to know the IP address of your system. The IP address, such as 192.0.2.1,
always has four components separated by periods.

• Select “local,” to choose a tape device that is connected to your system. You will
be prompted to enter the name of the tape device.

8. When you see the following message, remove the CD-ROM, insert your most recent
full backup tape, and then press Enter.

Insert the first backup tape in the drive, then press <Enter>,
[q]uit (from recovery), [r]estart:

There is a pause while the program retrieves several files from the tape describing
the system state at the time the backup was made. Then you see this message:

Erase /x filesystem and make new one (y,n)? [n]

It prompts you to answer for each filesystem that was known at the time of the
backup. Select an answer as follows:

• If you answer n for no, the system tries to salvage as many files as possible.
Then it uses your backup tape to replace the files it could not salvage. Usually
you should answer no, especially if your backup tape is not very recent. If the
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filesystems were badly damaged, or the backup was from an operating system
of a different level, you may need to answer yes.

• If you answer y for yes, the system erases the filesystem and copies everything
from your backup tape to the disk. The system loses any information on that
filesystem that you created between when you made your backup tape and
now.

9. You see this message:

Starting recovery from tape.

After two or three minutes, the names of the files that the system is copying to the
disk start scrolling. When the recovery is complete, you see this message:

Recovery complete, restarting system.

Note: If your backup tapes were old, or you were changing your operating system
level, you should reinstall the operating system from the IRIX CD that came with
your system after system recovery is complete. When you see the Startup System
message, press Esc, or click Stop for Maintenance. Then click Install System
Software. For more information on installing the operating system, see “Installing
Software” in the Personal System Administration Guide or see the Appendix of the
hardcopy Silicon Graphics O2+ Workstation Owner’s Guide.

Disabling the System Maintenance Password

If you select Install System Software, Run Diagnostics, Recover System, or Enter
Command Monitor from the System Maintenance menu, you may be prompted for a
password.

If you do not know the password, you can disable it by installing a jumper (a small cap
that connects two pins) on the system board inside the workstation. The system board is
located in the system module. To install the jumper, you must first remove the system
module and the PCI tray. Follow these steps:
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1. Turn off the workstation by pressing the power button on the front (Figure 4-8).

Figure 4-8 Turning Off the Workstation

2. Remove the system module by releasing the lever on the extreme left as you face the
rear of the workstation and sliding the module out. (See “Removing the System
Module” in Chapter 2).

3. Release and remove the PCI tray, as follows:

• If you have an RM7000class workstation, see “Removing a PCI Board in an
RM7000class Workstation” in Chapter 2.

• If you have an R12000class workstation, see “Removing a PCI Board in an
R12000class Workstation” in Chapter 2.

4. Before touching any of the components, attach the wrist strap to your wrist and to a
metal part of the chassis (Figure 4-9).
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Figure 4-9 Attaching the Wrist Strap

5. Remove the jumper from the system board in the location shown in Figure 4-10.

Note: You must remove the jumper if you choose to reset the PROM password.



114 007-4486-001

Chapter 4: Troubleshooting

.

Figure 4-10 Removing the Jumper

6. Reinstall the jumper in the location shown in Figure 4-11.

Note: The illustration shows an RM7000class CPU. In an R12000class CPU, the pin
location on the system board is the same.

Jumper
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Figure 4-11 Installing the Jumper

7. Remove the wrist strap.

8. Reinstall the PCI tray in the system module, as follows:

• If you have an RM7000class workstation, see “Reinstalling the PCI Tray in an
RM7000class Workstation” in Chapter 2.

• If you have an R12000class workstation, see “Reinstalling the PCI Tray in an
R12000class Workstation” in Chapter 2.

9. Reinstall the system module by sliding it into the chassis. See “Replacing the System
Module” in Chapter 5.

Service and Support Information

SGI provides a comprehensive product support and maintenance program for its
products. If you are in North America and would like support for your SGI products,
contact the Technical Assistance Center at 1-800-800-4SGI or your authorized service
provider. If you are outside North America, contact the SGI subsidiary or authorized
distributor in your country.
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Chapter 5

5. Ordering, Removing, Upgrading, Installing
Replacement Parts

If you suspect a hardware problem, use the diagnostic flowchart in “Diagnosing the
Problem” in Chapter 4 to help isolate the problem before contacting your local SGI
service provider.

The following topics are covered in this chapter:

• “Ordering a Replacement Part”

• “Replacing the System Module”

• “Replacing the RM7000class CPU Module”

• “Replacing the R12000class CPU Module”

• “Replacing the System Drive”

• “Replacing the Audio-visual Module”

• “Replacing the Power Supply”

• “Replacing the CD-ROM Drive”

• “Replacing the Chassis”

• “Replacing the PCB on the PCI Tray”

Ordering a Replacement Part

To order a replacement part, follow these steps:

1. Before contacting your local SGI service provider, locate the following information.
You can record the information in the space provided in Table 5-1.

• System serial number (see “Locating Your Workstation’s Serial Number” in
Chapter 1).

• Hardware configuration information including hardware upgrades and IRIX
software version (from the Toolchest, select System Manager).
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• Description of the problem.

2. Remove the faulty part if instructed by your service provider to do so, as follows:

• To remove memory modules, see “Removing Memory Modules” in Chapter 2.

• To remove a PCI board, see “Removing a PCI Board in an RM7000class
Workstation” in Chapter 2 or “Removing a PCI Board in an R12000class
Workstation” in Chapter 2.

• To remove an adapter board such as the Dual Channel Display Board (DCD),
see “Removing an Option Board” in Chapter 2.

• To remove the second optional hard drive, see “Removing the Second Internal
Hard Drive in an RM7000class workstation” in Chapter 3.

• To replace the system module, see “Replacing the System Module.”

• To replace the CPU module, see “Replacing the RM7000class CPU Module” or
“Replacing the R12000class CPU Module.”

• To replace the system drive, see “Replacing the System Drive.”

• To replace the audio-visual module, see “Replacing the Audio-visual Module.”

• To replace the power supply, see “Replacing the Power Supply.”

• To replace the CD-ROM drive, see “Replacing the CD-ROM Drive.”

• To replace the chassis, see “Replacing the Chassis.”

• To replace the PCB an the PCI tray, see “Replacing the PCB on the PCI Tray.”

Table 5-1 Information Needed for Support Call

System Serial Number

Model Number

IRIX Version

Description of Problem
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Replacing the System Module

If you are instructed by your service provider to replace the system module, you must
follow these steps:

Note: You must remove the PCI tray, because the printed circuit board beneath it
contains a host chip with important information such as the workstation’s serial number.

1. Remove the power cable, and remove the system module from the chassis. See
“Removing the System Module” in Chapter 2 and “Reinstalling the System
Module” in Chapter 2.

2. Remove all of the DIMM modules from the system module that you are returning
and reinstall them on the replacement system module. See “Removing Memory
Modules” in Chapter 2 and “Installing Memory Modules” in Chapter 2.

3. Remove the PCI tray from the system module that you are returning, and reinstall it
on the replacement system module, as follows. If a PCI board is installed in the tray, do
not remove it from the tray.

• If you have an RM7000class workstations, see “Removing a PCI Board in an
RM7000class Workstation” in Chapter 2 and “Installing a PCI Board in an
RM7000class Workstation” in Chapter 2.

• If you have an R12000class workstations, see “Removing the PCI Tray in an
R12000class Workstation” in Chapter 2 and “Installing a PCI Board in an
R12000class Workstation” in Chapter 2.

4. Remove the CPU module from the system module that you are returning, and
reinstall it on the replacement system module, as follows:

• If you have an RM7000class workstation, see “Replacing the RM7000class CPU
Module.”

• If you have an R12000class workstation, see “Replacing the R12000class CPU
Module.”

5. Remove the digital display adapter board, if one is installed, and reinstall it on the
replacement system module. See “Removing an Option Board” in Chapter 2 and
“Installing an Option Board” in Chapter 2.

6. Ship the stripped-down system module back to SGI in the container that held the
new system module.
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Replacing the RM7000class CPU Module

If you are instructed by your service provider to replace the RM7000class CPU module,
follow these steps.

1. If you have not already done so, turn off the workstation, remove the power cable,
and remove the system module from the chassis. See “Removing the System
Module” in Chapter 2.

2. Release the PCI tray by pushing up the lever on the side (Figure 5-1). The tray pops
up.

Figure 5-1 Releasing the PCI Tray on the RM7000class Workstation

3. Push down slightly on the rear of the PCI tray and remove it from the system
module (Figure 5-2). Do not remove the PCI board (if one is installed) from the tray.
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Figure 5-2 Removing the PCI Tray

4. Before touching any of the components, ground yourself to a metal part of the
chassis. Attach the wrist strap to your wrist and to the metal flange (Figure 5-3).

Figure 5-3 Attaching the Wrist Strap
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5. Locate the RM7000class CPU module (Figure 5-4). Use a Phillips screwdriver to
remove the two screws from the locations shown.

Note: The illustrations show the current CPU. Future CPUs may look slightly
different, but the installation steps are the same.

Figure 5-4 Removing the Phillips Screws on the RM7000class CPU Module
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6. Grasp the CPU module on both sides and gently rock it out (Figure 5-5). Do not
exaggerate the rocking motion because you should not bend the pins.

Figure 5-5 Removing the RM7000class CPU Module
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7. Install the replacement RM7000class CPU module (Figure 5-6), as follows:

• Align the connector beneath the module with the connector on the system
board. Make sure it is positioned correctly before pressing down.

• Press down gently on the CPU module until it is securely seated. You hear a
click as it connects.

• Insert and tighten the two Phillips screws in the locations shown (Figure 5-6).

Figure 5-6 Installing the Replacement CPU Module

8. Remove the wrist strap.
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9. Reinstall the PCI tray in the system module (Figure 5-7).

• Push the lever on the side of the tray to return it to its starting position.

• Engage the hinge on the PCI tray in the slot.

• Lower the tray as you push toward the back of the system module.

• Align the gold-colored PCI edge connector with the slot on the system board.

Figure 5-7 Replacing the PCI Tray in the System Module
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10. Push the tray down firmly until it is completely seated. Check that the lever returns
to its starting position (Figure 5-8).

Note: If the PCI tray is not completely seated, the system module will not slide back
into the chassis.

Figure 5-8 PCI Tray Seated Correctly

11. Reinstall the system module, and reconnect the cables. See “Reinstalling the System
Module” in Chapter 2.

12. Ship the old CPU module to SGI in the container that held the replacement CPU
module.

Replacing the R12000class CPU Module

If you are instructed by your service provider to replace the R12000class CPU module,
you must follow these steps:

1. If you have not already done so, turn off the workstation, remove the power cable,
and remove the system module from the chassis. See “Removing the System
Module” in Chapter 2

2. Remove the plastic faceplate from the system module by using a Phillips
screwdriver to remove five screws on the rear and two screws on the underside, in
the locations shown (Figure 5-9). Keep the two screws from the underside separate.
When reinstalling the faceplate, you must use the same screws.
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Caution: On the underside, remove only two screws. Do not remove the third screw
that attaches the lever to the face plate.

Figure 5-9 Removing Seven Screws from the Faceplate

3. Remove the faceplate by grasping it where the plastic comes to a “V” and pulling it
outward (Figure 5-10). The filler panel covering the I/O port falls away as you
remove the faceplate.

!
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Figure 5-10 Removing the Faceplate from the System Module

4. Release the PCI tray from the system module, as follows. If a PCI board is installed in
the tray, do not remove it from the tray. However, you need to disconnect any cables attached
to the PCI board.

• Insert a screwdriver in the small opening shown in Figure 5-11. Use a twisting
motion to release the PCI connector from the slot on the system module. Then
use an up and down motion to release the PCI tray.

• Pull the PCI tray straight up to remove it, and then set it aside.
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Figure 5-11 Releasing the PCI Tray from the System Module

5. Before touching any of the components, ground yourself to a metal part of the
chassis. Attach the wrist strap (Figure 5-12) as follows:

• Wrap the first two folds of the wrist strap around your wrist.

• Peel the liner from the copper foil at the opposite end.

• Attach the copper foil to the chassis.
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Figure 5-12 Attaching the Wrist Strap

6. Locate the R12000class CPU module. It is protected by a metal heat sink
(Figure 5-13). Do not remove the heat sink.

7. Use a Phillips screwdriver to remove four screws from the locations shown
(Figure 5-13).

Caution: Do not remove the four hex screws. Do not remove the two screws that
secure the fan.!



Replacing the R12000class CPU Module

007-4486-001 131

Figure 5-13 Removing the Screws from the R12000class CPU Module

8. Grasp the CPU module on both sides and gently rock it out (Figure 5-14). Do not
exaggerate the rocking motion because you should not bend the pins. Set the CPU
module aside.

Figure 5-14 Removing the R12000class CPU Module
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9. Install the replacement R12000class CPU module (Figure 5-15), as follows:

• Align the screw holes on the CPU module with the screw holes on the CPU
support. Make sure the CPU module is positioned correctly before pressing
down.

• Press down gently on the CPU module until it is securely seated. You hear a
click as it connects.

• Insert and tighten the four Phillips screws in the locations shown.

Figure 5-15 Securing the R12000class CPU Module

10. Remove the wrist strap.

11. Replace the PCI tray in the system module, as follows:

• Lower the PCI tray, engaging it on the metal rear panel of the system module
(Figure 5-16).

• Insert the PCI connector beneath the tray into the slot on the system module.

• Once the connector is aligned, push down firmly until it is completely seated.
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Note: If the PCI tray is not completely seated, the system module will not slide back
into the chassis.

Figure 5-16 Replacing the PCI Tray in the R12000class System Module

12. Replace the faceplate by sliding it onto the system module, while at the same time
lifting slightly at the “V” to snap it in place (Figure 5-17).

When properly seated, the underside of the faceplate is flush to the module and the
screw holes are aligned.
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Figure 5-17 Replacing the Faceplate

13. Align the screw holes on the faceplate with the screw holes on the system module.
Use a Phillips screwdriver to insert and tighten two screws on the underside in the
locations shown (Figure 5-18).

14. Replace the filler panel over the I/O opening on the inside of the module. It snaps
into place. If it does not seem to fit, turn it 180 degrees and try again.
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Figure 5-18 Replacing Two Screws on the Underside

15. Use a Phillips screwdriver to insert and tighten five screws in the locations shown
(Figure 5-19).
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Figure 5-19 Replacing Five Screws on the Faceplate

16. Follow the steps in “Reinstalling the System Module” in Chapter 2.

17. Ship the original CPU module to SGI in the container that held the replacement
CPU module.
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Replacing the System Drive

If you are instructed by your service provider to replace the system drive, you must
follow these steps:

1. Turn off the workstation (Figure 5-20).

Figure 5-20 Turning Off the Workstation
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2. Remove the power cable from the rear (Figure 5-21).

Note: The illustrations show an RM7000class workstation. The process of replacing
the system drive is the same on an R12000class workstation.

Figure 5-21 Removing the Power Cables
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3. Pull down the lever on the left side of the system drive module to release it
(Figure 5-22).

Figure 5-22 Releasing the Drive Tray
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4. Pull the system drive module out of the chassis (Figure 5-23).

Figure 5-23 Removing the System Drive Module from the Chassis

5. Slide the replacement system drive module into the system drive bay (Figure 5-24).

Figure 5-24 Installing the Replacement System Drive Module
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6. Push the lever up to lock the module in place (Figure 5-25).

Figure 5-25 Securing the System Drive Module

7. Reconnect the power cable (Figure 5-26) and turn on the workstation.
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Figure 5-26 Reconnecting the Power Cable

Replacing the Audio-visual Module

If you are instructed by your service provider to replace the audio-visual module, follow
these steps:
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1. Turn off the workstation (Figure 5-27).

Figure 5-27 Turning Off the Workstation
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2. Remove the power cable and any cables that are connected to the rear or side panel
of the audio-visual module (Figure 5-28).

Note: The illustrations show an RM7000class workstation. The process of replacing
the audio-visual module is the same on an R12000class workstation.

Figure 5-28 Removing the Cables from the Audio-visual Module
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3. Pull down the lever on the left side of the audio-visual module to release it
(Figure 5-29).

Figure 5-29 Releasing the Audio-visual Module
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4. Slide the audio-visual module out of the chassis (Figure 5-30).

Figure 5-30 Removing the Audio-visual Module from the Chassis
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5. Slide the replacement audio-visual module into the chassis (Figure 5-31).

Figure 5-31 Installing the Replacement Audio-visual Module

6. Push the lever up to lock the module in place (Figure 5-32).

Figure 5-32 Securing the Audio-visual Module
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7. Reconnect the power cable and any audio-visual cables that you removed earlier
(Figure 5-33).

Figure 5-33 Reconnecting the Audio-visual Cables

8. Turn on the workstation (Figure 5-34).

Figure 5-34 Turning on the Workstation
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Replacing the Power Supply

If you are instructed by your service provider to replace the power supply, follow these
steps:

1. Turn off the workstation (Figure 5-35).

Figure 5-35 Turning Off the Workstation
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2. Remove the power cable from the rear (Figure 5-36).

Note: The illustrations show an RM7000class workstation. The process of replacing
the power supply is the same on an R12000class workstation.

Figure 5-36 Removing the Power Cable
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3. To release the bezel that covers the power supply, press the latch at the top of the
bezel (Figure 5-37). It swings out toward you. Remove it from the chassis.

Figure 5-37 Removing the Bezel from the Power Supply
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4. Slide the lever to the right to release the power supply (Figure 5-38).

Figure 5-38 Releasing the Power Supply
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5. Grasp the pull ring and slide the power supply out of the chassis (Figure 5-39). Put
it aside.

Figure 5-39 Removing the Power Supply from the Chassis
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6. Slide the new power supply into the chassis, pushing it until it stops (Figure 5-40).

Figure 5-40 Installing the Replacement Power Supply
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7. Push the lever to the left until it clicks (Figure 5-41).

Figure 5-41 Locking the Power Supply in Place
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8. Replace the bezel over the power supply. Place the tabs at the bottom of the bezel in
the slots on the chassis and snap it up into place (Figure 5-42).

Figure 5-42 Replacing the Bezel on the Power Supply
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9. Reconnect the power cable (Figure 5-43), and turn on the workstation.

Figure 5-43 Reconnecting the Power Cable
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Replacing the CD-ROM Drive

If you are instructed by your service provider to replace the CD-ROM drive, follow these
steps. (Note that you must first remove the exterior covers before you can reach the
drive.)

1. If the CD eject button does not work, insert a straightened paper clip in the tiny hole
beneath the eject button to release the CD-ROM tray (Figure 5-44). (The CD eject
button may not work if the CD-ROM has failed.)

Figure 5-44 Opening the CD-ROM Drive
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2. Remove the CD-ROM drive faceplate, as follows (Figure 5-45).

• Hold the faceplate between the thumb and forefinger of one hand, while
bracing the tray with the other hand.

• Push the faceplate (but not the tray) upward with your thumb until it snaps
away from the tray.

• Push the tray gently back into the drive until it is just inside the bezel. Do not
push it all the way. Later it will be easier for you later to extract the tray to
reinstall the face plate.

Figure 5-45 Removing the CD-ROM Drive Faceplate

3. Turn off the workstation and remove the power cable from the rear.

SiliconGraphics
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4. To release the bezel that covers the power supply, press the latch at the top of the
bezel. It swings out toward you (Figure 5-46). Remove it from the chassis.

Note: The illustrations show an RM7000class workstation. The process of replacing
the CD-ROM drive is the same on an R12000class workstation.

Figure 5-46 Removing the Power Supply Bezel
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5. Remove the top cover of the CD-ROM drive (Figure 5-47) as follows:

• Look beneath the plastic cover for a release tab.

• Press the tab toward the chassis and push the cover upward.

Figure 5-47 Removing the Top Cover of the CD-ROM Drive
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6. Use a Phillips screwdriver to remove the two screws that secure the outer cover
(Figure 5-48).

Figure 5-48 Removing the Two Phillips Screws
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7. Remove the outer cover by grasping the plastic cross-piece and lifting up the cover
(Figure 5-49).

Figure 5-49 Removing the Outer Cover
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8. Use a Phillips screwdriver to remove the two screws that secure the CD-ROM drive
(Figure 5-50).

Figure 5-50 Removing the Screws from the CD-ROM Drive
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9. Tilt the CD-ROM drive upward and unhinge it from the chassis (Figure 5-51).

Caution: The CD-ROM drive has sharp metal edges. Be cautious when you handle
it.

Figure 5-51 Removing the CD-ROM Drive

!

1

2
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10. Disconnect the SCSI and power cables (Figure 5-52) as follows:

• Remove the SCSI cable by pulling on the thin plastic tab attached to the cable.

• Remove the four-wire power cable by pulling on the wing tabs on either side of
the connector. It may be tight, and you may need to wiggle it slightly as you
pull.

Figure 5-52 Disconnecting the SCSI and Power Cables

11. Place the faulty CD-ROM drive aside.
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12. Reconnect the SCSI cable and the four-wire power cable to the replacement
CD-ROM drive (Figure 5-53). Press each connector in firmly.

13. Tuck the excess length of the SCSI cable with the terminator into the cavity between
the connector and the sheet metal.

Figure 5-53 Reconnecting the SCSI and Power Cables
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14. Install the replacement CD-ROM drive by sliding the two hinges on the drive’s
bezel into the slots on the chassis and lowering the drive until it is fully seated
(Figure 5-54). Make sure that you do not pinch the SCSI and power cables as you
lower the drive.

Figure 5-54 Installing the Replacement CD-ROM Drive
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15. Insert and tighten the two screws that secure the CD-ROM drive (Figure 5-55).

Figure 5-55 Securing the CD-ROM Drive
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16. Replace the outer cover by aligning the two screw holes on the cover with the screw
holes in the CD-ROM tray and lowering the cover until it is fully seated
(Figure 5-56).

Figure 5-56 Replacing the Outer Cover
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17. Insert and tighten the two screws that secure the outer cover (Figure 5-57).

Figure 5-57 Securing the Outer Cover
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18. Replace the top cover (Figure 5-58) as follows:

• Hold it at an angle and slide the tabs at the front end under the outer cover.

• Lower it until the release tab snaps into place.

Figure 5-58 Replacing the Top Cover of the CD-ROM Drive
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19. Replace the plastic bezel over the power supply by inserting the hinges into the slots
beneath the power supply and pivoting the bezel up until it snaps into place
(Figure 5-59).

Figure 5-59 Replacing the Power Supply Bezel
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20. Replace the CD-ROM drive faceplate (Figure 5-60) as follows:

• Pull the tray out gently.

• Align the guides on the sides of the faceplate with the grooves on the sides of
the CD-ROM tray.

• Push the faceplate down while supporting the tray, until the release tabs lock.
Do not place too much downward pressure on the tray.

• Push the tray back into the drive.

Figure 5-60 Replacing the CD-ROM Faceplate
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21. Reconnect the power cable (Figure 5-61) and turn on the workstation.

Figure 5-61 Reconnecting the Power Cable
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Replacing the Chassis

If you replace the chassis, you must remove all of the removable modules and reinstall
them on the new chassis. If you are instructed by your service provider to replace the
chassis, follow these steps:

Caution: The chassis has sharp metal edges. Be cautious when you handle it.

1. Turn off the workstation, remove the power cable, and remove the system module
from the chassis. See “Removing the System Module” in Chapter 2. Reinstall the
system module on the replacement chassis. See “Reinstalling the System Module”
in Chapter 2.

2. Remove the system disk drive and reinstall it on the replacement chassis. See
“Replacing the System Drive.”

3. If you have an RM7000class workstation with an optional internal hard drive
installed, remove it and reinstall it on the replacement chassis. See “Removing the
Second Internal Hard Drive in an RM7000class workstation” in Chapter 3.

4. Remove the audio-visual module and reinstall it on the replacement chassis. See
“Replacing the Audio-visual Module.”

5. Remove the power supply and reinstall it on the replacement chassis. See
“Replacing the Power Supply.”

6. Remove the CD-ROM drive and reinstall it on the replacement chassis. See
“Replacing the CD-ROM Drive.”

7. Ship the stripped-down chassis, as shown in Figure 5-62 to SGI.

!
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Figure 5-62 Stripped-down Workstation Chassis

8. Reconnect the power cable and turn on the workstation.
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Replacing the PCB on the PCI Tray

The system serial number is stored electronically (nvram) on the printed circuit board on
the PCI tray. If nvram is corrupted, you may be instructed by your service provider to
replace the PCI tray that contains the printed circuit board. Follow these steps:

1. Turn off the workstation, remove the power cable, and remove the system module
from the chassis. See “Removing the System Module” in Chapter 2.

Note: You can find illustrations for all the following steps in “Installing a PCI Board
in an RM7000class Workstation” in Chapter 2, “Removing a PCI Board in an
RM7000class Workstation” in Chapter 2, “Installing a PCI Board in an R12000class
Workstation” in Chapter 2, and “Replacing the R12000class CPU Module” in
Chapter 5.

2. Remove the PCI tray from the system module.

3. If a PCI board is installed in the tray, remove it. If not, remove the filler panel and
screw.

4. Reinstall the PCI board into the new PCI tray. If no PCI board was installed, reinstall
the filler panel and screw.

5. Reinstall the PCI tray into the system module.

6. Reinstall the system module into the chassis. See “Reinstalling the System Module”
in Chapter 2.

7. Ship the PCI tray with the faulty PCB to SGI in the container that contained the new
PCI tray.
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Chapter 6

6. Safety and Regulatory Information

This chapter provides guidelines for adjusting your work surface to increase your
comfort and safety. It also contains environmental specifications and regulatory
statements. The following topics are covered.

• “Regulatory Declarations”

• “Safety Instructions”

• “Human Factors Guidelines for Setting Up Your O2+ Workstation”

Regulatory Declarations

The following topics are covered in this section:

• “CMN Number”

• “CE Notice and Manufacturer's Declaration of Conformity”

• “Electromagnetic Emissions”

• “Shielded Cables”

• “Electrostatic Discharge”

• “Laser Compliance Statement”

• “Lithium Battery Statement”

The O2+ workstation conforms to several national and international specifications and
European Directives listed on the “Manufacturer’s Declaration of Conformity.” The CE
mark insignia displayed on each device is an indication of conformity to the European
requirements.
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Caution: This product has several governmental and third-party approvals, licenses,
and permits. Do not modify this product in any way that is not expressly approved by
SGI. If you do, you may lose these approvals and your governmental agency authority
to operate this device.

CMN Number

The model number, or CMN number, for the O2+ workstation is on the system label
underneath the workstation.

CE Notice and Manufacturer's Declaration of Conformity

The “CE” symbol indicates compliance of the device to directives of the European
Community. A “Declaration of Conformity” in accordance with the standards has been
made and is available from SGI upon request.

Electromagnetic Emissions

This section provides the contents of electromagnetic emissions notices from various
countries.

FCC Notice (USA Only)

This equipment complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions:

• This device may not cause harmful interference.

• This device must accept any interference received, including interference that may
cause undesired operation.

!
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Note: This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case you
will be required to correct the interference at your own expense.

If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, you are encouraged to try to
correct the interference by using one or more of the following methods:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment to an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

Caution: Changes or modifications to the equipment not expressly approved by the
party responsible for compliance could void your authority to operate the equipment.

Industry Canada Notice (Canada Only)

This Class A digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.

Cet appareil numérique német pas de perturbations radioélectriques dépassant les
normes applicables aux appareils numériques de Classe A préscrites dans le Règlement
sur les interferences radioélectriques établi par le Ministère des Communications du
Canada.

!
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VCCI Notice (Japan Only)

Figure 6-1 VCCI Notice (Japan Only)

Chinese Class A Regulatory Notice

Figure 6-2 Chinese Class A Regulatory Notice

Korean Class A Regulatory Notice

Figure 6-3 Korean Class A Regulatory Notice

Shielded Cables

The O2+ workstation is FCC-compliant under test conditions that include the use of
shielded cables between the server and its peripherals. Your workstation and any
peripherals you purchase from SGI have shielded cables. Shielded cables reduce the
possibility of interference with radio, television, and other devices. If you use any cables
that are not from SGI, ensure that they are shielded. Telephone cables do not need to be
shielded.

Optional monitor cables supplied with your workstation use additional filtering molded
into the cable jacket to reduce radio frequency interference.

Always use the cable supplied with your system. If your monitor cable becomes
damaged, obtain a replacement cable from SGI.
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Electrostatic Discharge

SGI designs and tests its products to be immune to the effects of electrostatic discharge
(ESD). ESD is a source of electromagnetic interference and can cause problems ranging
from data errors and lockups to permanent component damage.

It is important that you keep all the covers and doors, including the plastics, in place
while you are operating the server system. The shielded cables that came with the server
and its peripherals should be installed correctly, with all thumbscrews fastened securely.

An ESD wrist strap may be included with some products, such as memory or PCI
upgrades. The wrist strap is used during the installation of these upgrades to prevent the
flow of static electricity, and it should protect your system from ESD damage.

Laser Compliance Statement

The CD-ROM drive in this computer is a Class 1 laser product. The CD-ROM drive’s
classification label is located on the drive.

Lithium Battery Statement

Warning: Danger of explosion if battery is incorrectly replaced. Replace only with
the same or equivalent type recommended by the manufacturer. Discard used
batteries according to the manufacturer’s instructions.

Safety Instructions

Read the following instructions carefully:

• Follow all warnings and instructions marked on the product and noted in this and
other documentation included with this product.

• Unplug this product from the wall outlet before cleaning. Do not use liquid cleaners
or aerosol cleaners. Use a damp cloth for cleaning.

• Do not use this product near water.
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• Do not place this product or components of this product on an unstable cart, stand,
or table. The product may fall, causing serious damage to the product.

• Slots and openings of the workstation are provided for ventilation. To ensure
reliable operation of the product and to protect it from overheating, these openings
must not be blocked or covered. This product should never be placed near or over a
radiator or heat register, or in a built-in installation unless proper ventilation is
provided.

• This product should be operated from the type of power indicated on the marking
label. If you are not sure of the type of power available, consult your dealer or local
power company.

• Do not allow anything to rest on the power cord. Do not locate this product where
persons will walk on the cord.

• Never push objects of any kind into this product through cabinet slots as they may
touch dangerous voltage points or short out parts that could result in a fire or
electric shock. Never spill liquid of any kind on the product.

• Do not attempt to service this product yourself except as noted in this guide.
Opening or removing covers of node and switch internal components may expose
you to dangerous voltage points or other risks. Refer all servicing to qualified
service personnel.

• Unplug this product from the wall outlet and refer servicing to qualified service
personnel under the following conditions:

• When the power cord or plug is damaged or frayed.

• If liquid has been spilled into the product.

• If the product has been exposed to rain or water.

• If the product does not operate normally when the operating instructions are
followed. Adjust only those controls that are covered by the operating
instructions since improper adjustment of other controls may result in damage
and will often require extensive work by a qualified technician to restore the
product to normal condition.

• If the product has been dropped or the cabinet has been damaged.

• If the product exhibits a distinct change in performance, indicating a need for
service.

• Replace the lithium battery on the motherboard only with the same type or an
equivalent type recommended by the manufacturer. Discard used batteries
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according to the manufacturer’s instructions. There is a danger of explosion if the
battery is incorrectly replaced.

• Use only the proper type of power supply cord set (provided with the system) for
this unit.

Human Factors Guidelines for Setting Up Your O2+ Workstation

You can increase the comfort and safety of your work environment, and decrease your
chances of repetitive strain injuries by following the guidelines given below. These
guidelines help you create a healthy and productive work environment.

To browse through additional information on setting up your workstation area, taking
frequent breaks, helpful exercises, and safe work habits, see Hardware Central. If your
Web browser is not loaded, it takes a few seconds to load. (This option is not available if
you are viewing this on a remote server.)

ANSI Standard for Visual Display Terminal Workstations

Table 6-1 shows recommended guidelines for furniture and system adjustment, as
developed by American National Standards Institute (ANSI).1

Figure 6-4 illustrates the adjustment parameters shown in Table 6-1. Guidelines are
shown for small females (standing height of 150 cm, or 59 in) and large males (standing
height of 185 cm, or 73 in.). Midpoints are also interpolated for persons of average height.

Local Visual Display Terminal (VDT) guidelines issued by your country, state, or
municipality may apply and supersede the guidelines in Table 6-1.

1 American National Standard for Human Factors Engineering of Visual Display Terminal Workstations.
ANSI/HFS 100-1988. Available from Human Factors Society, Inc., P.O. Box 1369, Santa Monica, CA,
90406, USA.
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Figure 6-4 Basic Parameters of VDT Workstation Adjustment

Table 6-1 ANSI/HFS 100-1988 Guidelines for VDT Workplace Adjustment

Adjustment Small Female Midpoint Large Male

Seat pan height 40.6 cm (16.0 in) 46.3 cm (18.2 in) 52.0 cm (20.5 in)

Work surface height
(keyboard and mouse)

58.5 cm (23.0 in) 64.75 cm (25.5 in) 71.0 cm (28.0 in)

Screen viewing height 103.1 cm (40.6 in) 118.1 cm (46.5 in) 133.1 cm (52.4 in)

Screen viewing distance >30.5 cm (>12 in) >30.5 cm (>12 in) >30.5 cm (>12 in)

Screen viewing angle 0-60 degrees 0-60 degrees 0-60 degrees

0º-60º

Work
Surface
Height Seat

Pan
Height

Screen
Viewing
Height

Screen
Viewing
Angle

Screen Viewing
Distance
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CAD Operator Preferences

If you work on a CAD system, you may feel more comfortable using the ranges of
adjustment shown in Table 6-2.2

The negative monitor tilt shown is Table 6-2 indicates that the monitor is tilted forward
(the top of the screen is tilted toward the user).

2 Derived from Grandjean, Etienne. Ergonomics in computerized Offices. London: Taylor & Francis Ltd.,
1987, p. 148.

Table 6-2 Workstation Adjustments Preferred by CAD User

Adjustment Mean Range

Seat pan height 54 cm (21.3 in) 50-57 cm (19.7-22.4 in)

Work surface height 73 cm (28.7 in) 70-80 cm (27.6 -31.5 in)

Monitor center above floor 113 cm (44.5 in) 107-115 cm (42.1-45.3 in)

Screen viewing distance 70 cm (27.6 in) 59-78 cm (23.2-30.7 in)

Work surface tilt 8.6 degrees 2-13 degrees

Monitor tilt -7.7 degrees -15-1 degrees
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Appendix A

A. Technical Specifications

To see this information in a Web browser, see Hardware Central. (If your Web browser is
not loaded, it takes a few seconds to load.) Or, if you are viewing this on a remote system,
see the following sections:

• “Cable Pinout Assignments”

• “Serial Cables and Converters”

• “O2 Camera Technical Specifications”

• “Physical Environment Specifications”

Cable Pinout Assignments

This section contains cable pinout information for the following O2+ ports:

• “Serial”

• “Parallel”

• “Ethernet 10-Base T/100-Base T”

• “Keyboard and Mouse”

• “SCSI”

• “Audio”

• “Composite Video (Analog) In and Out”

• “S-Video (Analog) In and Out”

• “Digital Video In and Out”

• “Monitor”

• “Stereo View”

• “Presenter 1280 Flat Panel Adapter (Optional)”

• “Digital Video Option Port (Optional)”
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Serial

Table A-1 shows cable pinout assignments for the serial ports.

Parallel

Table A-2 shows the cable pinout assignments for the IEEE 1284-C parallel port for the
Silicon Graphics floppy drive or for a printer. (The floppy drive has an additional
connector for a printer.)

Table A-1 Serial Port Pinout Assignments

Pin Assignment Description

1 DCD Data Carrier Detect

2 RD Receive Data

3 TD Transmit Data

4 DTR Data Terminal Ready

5 SG Signal Ground

6 DSR Data Set Ready

7 RTS Request to Send

8 CTS Clear to Send

9 RI Ring Indicator

Table A-2 Parallel Port (IEEE 1284-C) Pinout Assignments

Pin Assignment Pin Assignment

1 BUSY 19 SIGNAL GROUND (BUSY)

2 SELECT 20 SIGNAL GROUND (SELECT)

3 nACK 21 SIGNAL GROUND (nACK)

4 nFAULT 22 SIGNAL GROUND (nFAULT)

5 pERROR 23 SIGNAL GROUND (pERROR)
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Ethernet 10-Base T/100-Base T

Table A-3 shows the cable pinout assignments for the Ethernet 10-Base T/100-Base T
port.

6 DATA 1 24 SIGNAL GROUND (DATA 1)

7 DATA 2 25 SIGNAL GROUND (DATA 2)

8 DATA 3 26 SIGNAL GROUND (DATA 3)

9 DATA 4 27 SIGNAL GROUND (DATA 4)

10 DATA 5 28 SIGNAL GROUND (DATA 5)

11 DATA 6 29 SIGNAL GROUND (DATA 6)

12 DATA 7 30 SIGNAL GROUND (DATA 7)

13 DATA 8 31 SIGNAL GROUND (DATA 8)

14 nINIT 32 SIGNAL GROUND (nINIT)

15 nSTROBE 33 SIGNAL GROUND (nSTROBE)

16 nSELECTIN 34 SIGNAL GROUND (nSELECTIN)

17 nAUTOFD 35 SIGNAL GROUND (nAUTOFD)

18 HOST LOGIC HIGH 36 PERIPHERAL LOGIC HIGH

Table A-3 Ethernet 10-Base T/100-Base T Port Pinout Assignments

Pin Assignment

1 TRANSMIT+

2 TRANSMIT–

3 RECEIVE+

4 (Reserved)

5 (Reserved)

Table A-2 (continued) Parallel Port (IEEE 1284-C) Pinout Assignments

Pin Assignment Pin Assignment
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Keyboard and Mouse

Table A-4 shows the cable pinout assignments for the keyboard and mouse ports.

SCSI

Table A-5 shows the cable pinout assignments for the SCSI port.

6 RECEIVE–

7 (Reserved)

8 (Reserved)

Table A-4 Keyboard and Mouse Ports (6-pin MiniDIN) Pinout Assignments

Pin Assignment

1 KEYBOARD/MOUSE DATA

2 (Reserved)

3 GROUND

4 KEYBOARD/MOUSE POWER (+5V)

5 KEYBOARD/MOUSE CLOCK

6 (Reserved)

Table A-5 SCSI Port Pinout Assignments

Pin Assignment Pin Assignment

1 GROUND 35 -DB(12)

2 GROUND 36 -DB(13)

3 GROUND 37 -DB(14)

4 GROUND 38 -DB(15)

Table A-3 (continued) Ethernet 10-Base T/100-Base T Port Pinout Assignments

Pin Assignment
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5 GROUND 39 -DB(P1)

6 GROUND 40 -DB(0)

7 GROUND 41 -DB(1)

8 GROUND 42 -DB(2)

9 GROUND 43 -DB(3)

10 GROUND 44 -DB(4)

11 GROUND 45 -DB(5)

12 GROUND 46 -DB(6)

13 GROUND 47 -DB(7)

14 GROUND 48 -DB(P)

15 GROUND 49 GROUND

16 GROUND 50 GROUND

17 TERMPWR 51 TERMPWR

18 TERMPWR 52 TERMPWR

19 OPEN 53 OPEN

20 GROUND 54 GROUND

21 GROUND 55 -ATN

22 GROUND 56 GROUND

23 GROUND 57 -BSY

24 GROUND 58 -ACK

25 GROUND 59 -RST

26 GROUND 60 -MSG

27 GROUND 61 -SEL

28 GROUND 62 -C/D

Table A-5 (continued) SCSI Port Pinout Assignments

Pin Assignment Pin Assignment
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Audio

Figure A-1 shows the cable pinout assignments for the audio ports.

29 GROUND 63 -REQ

30 GROUND 64 -I/O

31 GROUND 65 -DB(8)

32 GROUND 66 -DB(9)

33 GROUND 67 -DB(10)

34 GROUND 68 -DB(11)

Table A-5 (continued) SCSI Port Pinout Assignments

Pin Assignment Pin Assignment
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Figure A-1 Audio Ports Pinout Assignments

Composite Video (Analog) In and Out

Table A-6 shows the cable pinout assignments for the analog composite video in and out
ports (RCA jack, NTSC, or PAL formats).

Table A-6 Analog Composite Video Port Pinout Assignments

Pin Assignment

2 (sleeve) GROUND

3 (tip) DATA

Ground/return

Signal

Ground/return

Signal

Ground/return

Ground/return

Left signal
Right signal

Left signal
Right signal

Stereo line-level
audio LEFT IN/OUT

Stereo line-level
audio RIGHT IN/OUT

Stereo headphone
auxiliary

stereo line out 3.5mm

Mono microphone
in 3mm

PORT PLUG
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S-Video (Analog) In and Out

Figure A-2 shows the cable pinout assignments for the analog S-video in and out port.
(The video option is not available on all models.)

Figure A-2 S-Video (Analog) Port Pinout Assignments

Chromain

Lumain

Chromaingnd

Lumaingnd

Chromaout

Lumaout

Chromaoutgnd

Lumaoutgnd

SDA

V12V

SCL

S-video in

S-video out
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Digital Video In and Out

Table A-7 shows the cable pinout assignments for the digital video in/out port for the
Silicon Graphics O2Cam digital video camera. (This video option is not available on all
models.)

Table A-7 Digital Video Port for O2Cam

Pin Assignment Pin Assignment

1 +5V 35 +5V

2 I2C_SCL 36 I2C_SDA

3 GPI IN 37 GPI OUTGND

4 GPI INGND 38 GPI OUT

5 OUTDATACLK 39 CAM MIC POS

6 OUTDATACLKGND 40 CAM MIC NEG

7 INDATA9GND 41 OUTDATA9

8 INDATA9 42 OUTDATA9GND

9 INDATA8GND 43 OUTDATA8

10 INDATA8 44 OUTDATA8GND

11 INDATA7GND 45 OUTDATA7

12 INDATA7 46 OUTDATA7GND

13 INDATA6GND 47 OUTDATA6

14 INDATA6 48 OUTDATA6GND

15 INDATA5GND 49 OUTDATA5

16 INDATA5 50 OUTDATA5GND

17 INDATA4GND 51 OUTDATA4

18 INDATA4 52 OUTDATA4GND

19 INDATA3GND 53 OUTDATA3

20 INDATA3 54 OUTDATA3GND
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Monitor

Table A-8 shows the cable pinout assignments for the O2+ monitor DSUB15 port.

21 INDATA2GND 55 OUTDATA2

22 INDATA2 56 OUTDATA2GND

23 INDATA1GND 57 OUTDATA1

24 INDATA1 58 OUTDATA1GND

25 INDATA0GND 59 OUTDATA0

26 INDATA0 60 OUTDATA0GND

27 INDATACLK 61 RESERVED

28 INDATACLKGND 62 RESERVED

29 RESERVED 63 RESERVED

30 -12V 64 +12V

31 RESERVED 65 RESERVED

32 RESERVED 66 RESERVED

33 RESERVED 67 RESERVED

34 RESERVED 68 RESERVED

Table A-8 Monitor Port (DSUB15) Pinout Assignments

Pin Assignment

1 RED

2 GREEN (complete sync in some modes)

3 BLUE

4 RESERVED

Table A-7 (continued) Digital Video Port for O2Cam

Pin Assignment Pin Assignment
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Stereo View

Table A-9 shows the cable pinout assignments for the stereo view port on the optional
Presenter 1280/stereo view adapter board.

5 GROUND

6 RED RETURN

7 GREEN RETURN

8 BLUE RETURN

9 +5V, limited current

10 GROUND

11 RESERVED

12 IIC DATA

13 HORIZONTAL SYNC

14 VERTICAL SYNC

15 IIC CLOCK

Table A-9 Optional Stereo View Port Pin Assignments

Pin Assignment

1 STEREO POWER (+12V, 0.5A)

2 STEREO GROUND

3 VERTICAL - ODD FIELD

Table A-8 (continued) Monitor Port (DSUB15) Pinout Assignments

Pin Assignment
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Presenter 1280 Flat Panel Adapter (Optional)

Table A-10 shows the cable pinout assignments for the optional Presenter 1280 adapter
board.

Table A-10 Presenter 1280 Monitor Port (Optional)

Pin Assignment Pin Assignment

1 RED_P[0] 35 RED_P[1]

2 RED_N[0] 36 RED_N[1]

3 RED_P[2] 37 RED_P[3]

4 RED_N[2] 38 RED_N[3]

5 RED_P[4] 39 RED_P[5]

6 RED_N[4] 40 RED_N[5]

7 RED_P[6] 41 RED_P[7]

8 RED_N[6] 42 RED_N[7]

9 GRN_P[0] 43 GRN_P[1]

10 GRN_N[0] 44 GRN_N[1]

11 GRN_P[2] 45 GRN_P[3]

12 GRN_N[2] 46 GRN_N[3]

13 GRN_P[4] 47 GRN_P[5]

14 GRN_N[4] 48 GRN_N[5]

15 GRN_P[6] 49 GRN_P[7]

16 GRN_N[6] 50 GRN_N[7]

17 BLUE_P[0] 51 BLUE_P[1]

18 BLUE_N[0] 52 BLUE_N[1]

19 BLUE_P[2] 53 BLUE_P[3]

20 BLUE_N[2] 54 BLUE_N[3]

21 BLUE_P[4] 55 BLUE_P[5]
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Digital Video Option Port (Optional)

Table A-11 shows the pinout assignments for the DB-9 connector on the O2+ digital video
option board.

22 BLUE_N[4] 56 BLUE_N[5]

23 BLUE_P[6] 57 BLUE_P[7]

24 BLUE_N[6] 58 BLUE_N[7]

25 FP_PIXEL_CLK_P 59 FP_HSYNC_CLK_P

26 FP_PIXEL_CLK_N 60 FP_HSYNC_CLK_N

27 FP_VSYNC_CLK_P 61 FP_AUDIO_R-P

28 FP_VSYNC_CLK_N 62 FP_AUDIO_R-N

29 POWERGOOD 63 FP_AUDIO_L-P

30 RESERVED 64 FP_AUDIO_L-N

31 CABLE_GND 65 CABLE_GND

32 CABLE_GND 66 CABLE_GND

33 FP_I2C_DATA 67 FP_I2C_CLK

34 CABLE_GND 68 CABLE_GND

Table A-11 DB-9 Connector Pinout Assignments

Pin Assignment

1 Analog Video Genlock In

2 Analog Video Genlock Gnd

3 GPI In

4 GPI In Gnd

5 NC

Table A-10 (continued) Presenter 1280 Monitor Port (Optional)

Pin Assignment Pin Assignment
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Serial Cables and Converters

This section contains cable pinout information for serial cables that you can connect to
your O2+ workstation. It also describes Silicon Graphics serial port converters. The
following topics are covered:

• “Printer/Dumb Terminal Serial Cable”

• “PC Modem Serial Cable”

• “Serial Port Converters”

Printer/Dumb Terminal Serial Cable

For serial printers and dumb terminals, use a 3-wired standard PC cable. Table A-12
shows the cable connector pinout assignments for this cable.

6 Analog Video Genlock loopthrough

7 Analog Video Genlock Gnd

8 GPI Out

9 GPI Out Gnd

Table A-11 (continued) DB-9 Connector Pinout Assignments

Pin Assignment
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Note: For a 3-wire cable and no hardware flow control modem, you must use the
/dev/ttyd* command devices in the configuration files. For more detailed information,
see the serial man page. To see the man page, from the Toolchest, select Help >
InfoSearch > Man pages. Or place the cursor in the console window and type: man
serial

PC Modem Serial Cable

Use a full-handshake (includes RTS and CTS) PC modem serial cable for a modem with
RTS/CTS flow control. Table A-13 shows the cable connector pin assignments for this
cable.

You can use this cable for all serial devices except those that do not need RTS flow control.
Devices like serial printers and dumb terminals that do not need RTS flow control can
still be used with this cable, provided that a null modem adapter is added to one end of
the cable. You can purchase the full-handshake PC modem serial cable from Silicon
Graphics or your local service provider.

Table A-12 Cable Pinout Assignments for Printer/Dumb Terminal Serial Cable

Signal
Description

Pin Number
DB9 Connector (Female)

Pin Number
DB-25 Connector (Male)

1 NOT CONNECTED

RXD 2 2

TXD 3 3

4 NOT CONNECTED

GND 5 7

6 NOT CONNECTED

7 NOT CONNECTED

8 NOT CONNECTED

9 NOT CONNECTED
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Note: If you are attaching a modem with modem signals and RTS/CTS flow control, you
must use the /dev/ttyf* command devices in the configuration files. For more detailed
information, see the serial man page. To access this man page, from the Toolchest, select
Help > InfoSearch > Man pages. Or place the cursor in the console window and type:
man serial

Serial Port Converters

The O2+ workstation’s serial ports conform to the PC standard pinout for EIA standard
RS-232 signals. The transmit and receive circuits are also capable of higher speed
signalling according to the EIA RS-423 standard. You can also convert these signals to
support other interfaces.

SGI offers two converters: one for the RS-422, commonly used for video deck control, and
an Apple Macintosh to MIDI converter for the RS-422-like signalling used by MIDI
devices to connect to Apple Macintosh serial ports.

Table A-13 Cable Pinout Assignments for PC Modem Cable

Signal
Description

Pin Number
DB-9 Connector (Female)

Pin Number
DB-25 Connector (Male)

DCD 1 8

RXD 2 3

TXD 3 2

DTR 4 20

GND 5 7

DSR 6 6

RTS 7 4

CTS 8 5

RI 9 22
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RS-422 Converter (DB-9 Female) for Video Deck Control

The Silicon Graphics RS-422 converter converts the O2+ workstation’s RS-232 Transmit
Data and Receive Data signals to SMPTE 207M-compatible RS-422 for video deck control.

Table A-14 shows the pinouts for the O2+ workstation end.

Table A-15 shows the pinouts for the video deck end.

Table A-14 RS-422 Converter (DB-9 Female): Workstation End

Workstation Signal
Description Pin Number

Voltage With Regard to Ground Received From or
Supplied to Workstation

DCD 1 Passed through from RS-422 spare

RXD 2 Supplies -5V typical low, +5V typical high (RS-423)

TXD 3 0V maximum low, 1.6V minimum high

DTR 4 Requires -12V maximum low, +12 V minimum high

SG 5 0

DSR 6 Not connected

RTS 7 Requires +12V to power the converter

CTS 8 Not connected

RD 9 Not connected

Table A-15 RS-422 Converter (DB-9 Female): Video Deck End

Video Deck End Signal
Description Pin Number

Voltage
(Across Pair)

Frame GND 1 Not connected

Spare (Priority In) 5 Passed through to workstation DCD

Controller Rcv A&B 2(-) and 7 Requires 0V maximum low, 1.6V minimum high

Controller Xmit A&B 8(-) and 3 Supplies 0V typical low, +5V typical high

Signal GND 4, 6 0

Frame GND 9 Not connected
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Macintosh to MIDI Converter (DB-9 Female to MiniDIN-8 Female)

The Silicon Graphics Macintosh to MIDI converter converts the O2+ workstation’s
RS-232 Transmit Data and Receive Data signals to RS-422-like signalling used by MIDI
devices to connect to Apple Macintosh serial ports.

Table A-16 shows the pinouts for the O2+ workstation end.

Table A-17 shows the pinouts for the MIDI interface end.

Table A-16 Macintosh to MIDI Converter (DB-9 Female): Workstation End

Workstation Signal
Description Pin Number

Voltage with Regard to Ground Required from or Supplied
to Workstation

DCD 1 Passed through from GPi

RXD 2 Supplies 0V typical low, +5V typical high

TXD 3 Requires 0V maximum low, 1.6V minimum high (RS-423)

DTR 4 Requires -12V maximum low to +12V minimum high

SG 5 0

DSR 6 Not connected

RTS 7 Requires +12V to power the converter

CTS 8 Passed through from handshake in

RD 9 Not connected

Table A-17 Macintosh to MIDI Converter (MiniDIN-8): MIDI Interface End

Macintosh Signal
Description Pin Number

Voltage with Regard to Ground Supplied to or
Required from MIDI Interface Unit

GPi 7 Passed through to DCD

RXD 5(-) and 8 Requires -0.2V maximum low, 0.2V minimum high

TXD 32(-) and 6 Supplies -5V typical low, +5V typical high

HANDSHAKE OUT 1 Supplies -5V typical low, +5V typical high

SIGNAL GROUND 4 0

HANDSHAKE IN 2 Passed through to DCD
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O2 Camera Technical Specifications

Table A-18 lists the technical specifications for the O2Cam.

Table A-18 O2Cam Technical Specifications

Sensor 512 x 480 NTSC Color CCD, 1/3 in. format.

Standard lens F2.0,  6mm with M11 screw mount and built-in IR filter.

Output format Outputs 640 x 480 square pixel NTSC frames @ 29.97 Hz (780 x 525 total
frame), as 422YCrCb pixels with 1 byte luminance followed by 1 byte
chrominance, on a 24.5 MHz interface clock.

Automatic Gain
Control

Automatic Gain Control adjusts gain to achieve average output
brightness. AGC can be activated or overridden (via new gain value) from
workstation.

Shutter speeds Selectable from 1/60 through 1/10,000 second.

Auto white balance Software initializes camera at workstation power on and loads red and
blue balance, red and blue saturation, and gamma values that are
balanced for offices with or without windows, with incandescent and/or
fluorescent lights. User can make additional white balance adjustments
with the digital media software.

Gamma correction Gamma factor of 0 or 255 can be loaded into camera by workstation at any
time.

Push button The control button drives the GPIBIN line on the 68-pin connector. While
button is up, voltage is high; while button is down, voltage is low.

Power requirements 1W @ 5V (200mA), 1W @ 12V (80mA), and 12 mW @ -12V (1mA) are
provided by the workstation. These are maximum amounts available to
the camera. Actual consumption should be lower.

LED indicator On/off state is controlled by the workstation via I2C.

Workstation interface DVCI uses 68-position 0.8 mm Champ connector on far end of attached
8-ft cable. Video is transmitted at TTL levels, 1 byte wide plus hsync and
vsync. All camera parameters  are accessed and controlled by the
workstation via I2C. Workstation provides 5V power.

Focus adjustment Focal distance from 3 in. to infinity with standard lens.

Microphone Built-in directional microphone and preamp produces a monaural,
single-ended line level signal.
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Physical Environment Specifications

Table A-19 lists the physical environment specifications for the O2+ workstation.

Table A-19 Physical Environment Specifications for the O2+ Workstation

Workstation dimensions 12 in. H x 9 in. D x 5 in. W

Power requirements 100 - 132 VAC, 2.4 - 1.8 A
200 - 264 VAC, 1.2 - 0.9 A
47 - 63 Hz

3-pin, earth-grounded plug

Ambient temperature +10° C to 35° C (operating)
-40° C to +65° C (non-operating)

Relative humidity 10% to 80% operating (no condensation)
5% to 90% non-operating (no condensation)

Heat dissipation 245 watts

Altitude 10,000 feet (operating)
40,000 feet (non-operating)

Vibration (operating) 0.02 inches displacement, 5-19 Hz
0.25 g, 5 - 100 Hz
Dwelling at each resonant frequency for 15 minutes

Vibration (non-operating) 0.1 inches displacement, 5-19 Hz
0.5 g, 5 - 500 Hz

Noise 35 dB (A) in typical operating position

Shock (operating) 5 g for 15 msec, half sine pulse in horizontal plan
7.5 g for 10 msec, half sine pulse in vertical plan

Shock (non-operating) 20 g for 10 msec, half sine pulse in all plans
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account

See login account.

active window

The only window that recognizes input (activity) from the keyboard and mouse; only
one window is active at a time.

address dial

See SCSI address dial.

administrator

The person who can use the most privileged account, root. The administrator must have
a personal login account for daily use, but to correct serious system problems, the
administrator logs in to the root account to change system information using the
graphical tools or using the IRIX shell.
The administrator has all the capabilities of a privileged user, plus the capability to
change information in the root account (such as the password) and to log in to an IRIX
shell as root. Because there is only one root account, there is only one administrator per
system. The Information Panel for a particular system includes the name of the system’s
administrator so other users know whom to contact for help.
See also network administrator and system administrator.

back up

To copy a certain set of files and directories from your hard disk to a tape or other media.

backup tape

A tape that contains a copy of a set of files and directories that are on your hard disk. A
full backup tape contains a copy of all files and directories, including IRIX, that are on
your hard disk.

baud rate

A term used for the speed (calculated as bits per second) at which the computer sends
information to a serial device, such as a modem or terminal.
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boot

To start the system by turning on the workstation and monitor; the system is fully booted
when you see the console login prompt or the login screen.

button

On a mouse, a button is a switch that you press with a finger. In a window on your screen,
a button is a labelled rectangle that you click with a mouse.

CCIR 601

A high-end digital video interface standard developed by the CCIR (Comité Consultatif
International de Radiodiffusion, or International Radio Consultative Committee). In
CCIR 601 the luminance and chrominance are broken down into three digital signals: one
for luminance (brightness) and two for chrominance (color) information. The color
information is spatially sub-sampled horizontally so that the two chroma components
occupy the same data bandwidth as the luminance component. Both the luminance and
chrominance are then multiplexed up to a double rate byte wide data stream. The SGI
digital standard used in the O2+ workstation is very similar to 601, with the exception
that 601 is balanced ECL, while SGI uses single-ended TTL. Additionally, 601 requires a
fixed number of samples per horizontal line, while the SGI implementation is
programmable.

CD-ROM disk (CD)

A flat metallic disk that contains information that you can view and copy onto your own
hard disk; you cannot change or add to the information on the CD-ROM. CD-ROM is the
shortened term for compact disk: read-only memory.

centralized network

A network in which a central server controls services and information; the server is
maintained by one or more network administrators. On a centralized network that uses
NIS, this server is the NIS master, and all other systems on the network are NIS clients.
See also network administrator.

chassis

The external metal framework of the workstation that contains its working parts.

chrominance

In an image reproduction system, a separate signal that contains the color information.
Black, white, and all shades of gray have no chrominance and contain only the luminance
(brightness) portion of the signal. All colors have both chrominance and luminance.
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Chrominance is derived from the I and Q signals in the NTSC television system and the
U and V signals in the PAL television system. See also luminance.

click

To press and immediately release a mouse button.

composite video

A color-encoding method or a video signal that contains all of the color, brightness, and
synchronizing information in one signal. The chief composite television standard signals
are NTSC, PAL, and SECAM. See also NTSC and PAL.

configuration file

A system file that you change to customize the way your system behaves. Such files are
sometimes referred to as customization files.

confidence test

A test that you run to make sure a particular device (such as the keyboard, mouse, or a
drive) is set up and working properly.

connector

Hardware at the end of a cable that lets you fasten the cable to an outlet, port, or another
connector.

console window

The window that appears as a stowed icon each time you log in; IRIX reports all status
and error messages to this window.

CPU module

The printed circuit board within your workstation chassis that contains the central
processing unit (CPU).

current working directory

The directory within the filesystem in which you are currently located when you are
working in a shell window.

cursor

The small red arrow on the screen that echoes the movements of the mouse. It changes
shape during different activities.
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DAT (digital audio tape)

A magnetic tape from which you can read and to which you can copy audio and digital
information.

default printer

The printer to which the system directs a print request if you do not specify a printer
when you make the request. To set the default printer use the Print Manager.

default subsystems

Portions of a product that are installed automatically if you do not customize a product
installation.

defaults

A set of behaviors that SGI specifies on every system. You can later change these
specifications, which range from how your screen looks to what type of drive you want
to use to install new software.

diagnostics

A series of tests that checks all hardware components of your system.

DIMM (double inline memory module)

A small printed circuit board with several chips that contain additional megabytes of
random-access memory (RAM).

DIMM socket

A long, thin, female connector located on the system board into which you insert a
DIMM.

directory

A container in the filesystem in which you store other directories and files.

disk resource

Any disk (hard, CD-ROM, floppy, or floptical) that you can access either because it is
physically attached to your workstation with a cable, or because it is available over the
network using NFS. See also NFS.

disk use

The percentage of space on your disk that contains information.
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double-click

To press and release a mouse button twice, very rapidly.

drag

To press and hold down a mouse button, and then move the mouse. This drags the cursor
to move icons or to highlight menu items.

drive

A hardware device that lets you access information on various forms of media, such as a
hard disk, floppy disk, CD-ROM, and magnetic tape.

drive address

See SCSI address.

external device

Any piece of hardware that is attached to the workstation with a cable.

export

To use NFS software to make all or part of your filesystem available to other users and
systems on the network.

female connector

A connector that has indentations or holes into which you plug a male connector. An
example of a female connector is an electrical wall outlet that accepts an electrical plug.

field

An area in a window in which you can type text.

file

A container in which you store information such as text, programs, or images that you
create using an application.

filesystem

A hierarchy of directories and files. Directories contain other directories and files; files
cannot contain directories. The root (/) directory is at the top of the hierarchy.

form

A window that contains buttons that you click and/or fields into which you enter
information.
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grounded electrical outlet

An electrical wall outlet that accepts a plug with a grounding prong. In the USA, all
three-prong outlets are grounded.

handshake

The protocol that controls the flow of information between a workstation and a printer
or any other peripheral. A hardware handshake uses only cable wires and pins to control
the flow. A software handshake (also called xon-xoff flow control) uses a combination of
pins, wires, and software.

highlight

To change the color of an item on the screen by positioning the cursor over the item,
pressing and holding the mouse button, and moving the cursor over the item.

home directory

The directory into which IRIX places you each time you log in. It is specified in your login
account; you own this directory and, typically, all its contents.

host

Any system connected to the network.

hostname

The name that uniquely identifies each host (system) on the network.

human factors guidelines

A set of standards and suggestions for making your working environment more
comfortable and healthy.

icon

A small picture that represents a stowed or closed file, directory, application, or IRIX
process.

internal drive

A drive that fits inside the workstation and connects to an internal port; it is never
connected with a cable to a visible external port. An internal drive is occasionally referred
to as a front-loading drive.
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IP address

The Internet Protocol number that uniquely identifies each host (system) on the network.
An example of an IP address is 192.0.2.1. It always has four components, separated by
periods.

IRIX

SKI’s version of the UNIX operating system. See also system software.

ISDN (Integrated Services Digital Network)

A combination of software, hardware, and telephone services that lets you communicate
with other systems and networks over a high-speed telephone line, just as you
communicate with other systems and networks over an Ethernet cable.

jot

The text editor that comes as a standard utility on Silicon Graphics workstations.

KB (kilobyte)

A standard unit for measuring the information storage capacity of disks and memory
(RAM and ROM); 1024 bytes is 1 KB.

LED (light-emitting diode)

A light on a piece of hardware that indicates status or error conditions.

launch

To start an application, often by double-clicking an icon.

local workstation, drive, disk, filesystem, or printer

The physical workstation whose keyboard and mouse you are using, all hardware that is
connected to that workstation, and all software that resides on that hardware or its
removable media.

log in

To enter your login name so you can start a session on the workstation.

log out

To end a session on the workstation.
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login account

A database of information about each user that, at the minimum, consists of login name,
user ID, and home directory.

login name

A name that uniquely identifies a user to the system.

login screen

The window that you see after powering on the system, before you can access files and
directories. The window can contain one icon for each login account on the system.

luminance

The perceived brightness of a surface. Luminance typically refers to a weighted average
of red, green, and blue color values that gives the perceived brightness of the
combination. For video systems, luminance is the video signal that describes the amount
of light in each pixel. See also chrominance.

MB (megabyte)

A standard unit for measuring the information storage capacity of disks and memory
(RAM and ROM); 1024 kilobytes is 1 MB.

male connector

A connector that has raised edges, pins, or other protruding parts that you plug into a
female connector. An example of a male connector is an electrical plug that you plug into
a wall outlet.

man page

An online document that describes how to use a particular IRIX command.

menu

A list of operations or commands that the workstation can execute.

MIDI (Musical Instrument Digital Interface)

On the O2+ workstation, MIDI devices (such as a keyboard) can be connected to the
serial ports.
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monitor

A hardware device that displays the images, windows, and text with which you interact
to use the system. It is also called a video display terminal (VDT).

monitor video cable

The cable that connects the monitor to the workstation to transmit video signals. It is
thick and beige, with large connectors on both ends.

monitor power cable

The cable that connects the monitor to the workstation to provide power to the monitor.
It is thick and beige, with a male connector on one end and a female connector on the
other.

mount point

The directory on your workstation from which you access information that is stored on
a local or remote disk resource.

mount

To make a filesystem that is stored on a local or remote disk resource accessible from a
specific directory on your workstation.

mouse

A hardware device you use to communicate with windows and icons. You move the
mouse to move the cursor on the screen, and you press its buttons to initiate operations.
An optical mouse must always be on the mouse pad for the IRIS system to interpret its
movements; a mechanical mouse works on any clean, flat surface.

mouse pad

For an optical mouse, this is the rectangular, metallic surface that “reads” the movements
of the mouse. For a mechanical mouse, this is a clean, soft rectangular surface that makes
the mouse’s track ball roll efficiently.

network

A group of computers and other devices (such as printers) that can all communicate with
each other electronically to transfer and share information.

network administrator

The individual(s) responsible for setting up, maintaining, and troubleshooting the
network, and for supplying setup information to system administrators of each system.
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NFS (Network File System)

A networking software option that lets you access files and directories that reside on the
disks of other workstations as if they resided on a local disk in your own workstation.

NTSC

A color television standard or timing format that encodes all of the color, brightness, and
synchronizing information in one signal. Used in North America, most of South
America, and most of the Far East, this standard is named after the National Television
Systems Committee, the standardizing body that created the system in the United States
in 1953. NTSC uses a total of 525 horizontal lines per frame, with two fields per frame of
262.5 lines each. Each field refreshes at 60 Hz (actually 59.94 Hz).

open

To double-click an icon, or to select an icon, and then select Open from a menu in order
to display a window.

option drive

Any internal drive other than the system disk. Option drives include floppy disk drives,
floptical disk drives, secondary hard disk drives, and DAT drives.

outlets

Openings in the hardware to which you attach connectors to make an electrical
connection.

PAL

The acronym for Phase Alternation Line or Phase Alternated by Line, by which the
workstation attempts to correct some of the color inaccuracies in NTSC. PAL is a color
television standard or timing format developed in West Germany and used by most
other countries in Europe (including the United Kingdom but excluding France), as well
as Australia and parts of the Far East. PAL uses a total of 625 horizontal lines per frame,
with two fields per frame of 312.5 lines per field. Each field refreshes at 50 Hz. PAL color
encoding is different from NTSC encoding. See also NTSC.

PCI (Peripheral Component Interconnect)

A bus specification. The PCI bus is a high-performance local bus used to connect
peripherals to memory and a microprocessor. Many vendors sell devices that plug into
the PCI bus.
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PROM monitor

The interface that you use to communicate with the system after it is powered on, but
before it is booted and running IRIX.

Printer Manager

A tool that you access from the System Manager. You use it to set up printer software and
monitor jobs that you send to the printer.

parallel device

Any hardware device that requires a parallel cable connection to communicate with the
workstation. A parallel interface transfers bits of information via a number of wires
simultaneously.

parallel port

An outlet on the workstation to which you connect external parallel devices. A parallel
interface transfers bits of information via a number of wires simultaneously.

password

A combination of letters and/or numbers that only you know; it is an optional element
of your login account. If you specify a password for your account, you must type it after
you type your login name before the system lets you access files and directories.

pathname

A name that specifies the location of a file or directory within a hierarchied filesystem. It
begins with the name of the root (/) directory and ends with the name of the subordinate
directory or files to be located. See also filesystem.

peripheral

A hardware device, such as a tape device, that adds more functionality to the basic
workstation. See also external device and internal drive.

port

An outlet on the workstation to which you attach cable connectors.

power-on diagnostics

A series of tests that automatically checks hardware components of your system each
time you turn it on.
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power cable

The cable that connects the workstation to a grounded electrical outlet.

power off

To turn off the power switches on the workstation chassis and the monitor.

power supply

The hardware within the chassis that directs power from an electrical outlet to the
chassis, the monitor, and internal SCSI devices. It also contains the power switch, reset
button, and fan.

power on

To turn on the power switches on the workstation chassis and the monitor.

prompt

A character or word that the system displays in an IRIX shell. It indicates that the system
is ready to accept commands. The default prompt for regular user accounts is %; the
default prompt for the root account is #.

quit

To stop running an application.

remote workstation, drive, disk, filesystem, or printer

A hardware device or the information or media it contains that you can access across the
network; it is not physically connected to your workstation.

reset button

A physical button on the workstation that you press to turn off and then immediately
restore power to the workstation. You should never press this button while IRIX is
running, unless all attempts to shut down the system using software fail. See also shut
down.

restore (files)

To copy files that once resided on your hard disk from another disk or tape back onto
your hard disk.
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root account

The standard IRIX login account reserved for use by the system administrator. This
account’s home directory is the root (/) directory of the filesystem; the user of the root
account has full access to the entire filesystem (that is, this user can change and delete
any file or directory). The user of this account is sometimes referred to as the super-user.
See also administrator and system administrator.

root (/) directory

The directory at the top of the filesystem hierarchy. See also filesystem.

SCSI (Small Computer System Interface)

SCSI (pronounced “scuzzy”) is a high-speed input/output specification for small
computers.

SCSI address

A number from one to seven that uniquely identifies a SCSI device to a system. No two
SCSI devices that are physically connected to the same workstation can have the same
SCSI address. See also SCSI.

SCSI address dial

A small plastic dial, supplied by SGI, that is connected to most external SCSI devices. You
click its small buttons to select a SCSI address for a new SCSI device. See also SCSI.

SCSI bus line

The combined length of all internal and external SCSI cables in a system. See also SCSI.

SCSI cable

A cable that connects a SCSI device to a SCSI port on a workstation. See also SCSI.

SCSI device

A hardware device that uses the SCSI protocol to communicate with the system. Hard
disks, floppy disks, floptical disks, CD-ROMs, and tape drives are all SCSI devices. See
also SCSI.

SCSI terminator

A metal cap that you plug into any open SCSI port on a SCSI bus line. No SCSI devices
on a SCSI bus line will work unless all SCSI ports are occupied by either cables or
terminators. See also SCSI.
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screen

The portion of the monitor that displays information.

select

To position the cursor over an item, and then click the mouse button.

serial device

Any hardware device that requires a serial cable connection to communicate with the
workstation.

serial port

An outlet on the workstation to which you connect external serial devices.

server

A system that other systems on network access to use its disk space, software, or services.

shell

A window into which you type IRIX commands.

shielded cable

A cable with a protective covering that reduces the possibility of interference with radio,
television, and other devices.

shut down

To safely close all files, log out, and bring the workstation to a state in which you can
safely power it off. From the Toolchest, select System > Shutdown.

software option

Any software product that you buy from SGI other than the standard system software
that comes on your system disk.

standalone workstation

A workstation that is not connected to a network.

static electricity

Whenever your body is in physical contact with metal parts (including printed circuit
boards) of computer equipment, there is the potential for you to feel an electrical shock
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(electro-static discharge or ESD) that could damage the equipment. To prevent this, you
must always wear a wrist strap when working with internal parts of a workstation.

subsystem

A portion of a software product. Each product consists of several subsystems; some are
required and some are optional.

super-user

An alternate name for the user of the root login account. See also administrator, root
account, and system administrator.

S-video

An increasingly popular analog video signal format that achieves higher picture quality
than composite video by passing the luminance (brightness) and chrominance (color)
information on separate wires.

system

All the hardware and software that make up the workstation.

system administrator

The individual(s) responsible for setting up, maintaining, and troubleshooting a
networked or standalone system.See also administrator and network administrator.

system crash

This occurs when the IRIX operating system fails and the system will not accept any
keyboard or mouse input.

system disk

The physical disk that contains the standard IRIX operating system software.

System Manager

A set of tools that the administrator uses to set up and manage the workstation. To access
the System Manager, from the Toolchest, you select System.

system software

The standard IRIX operating system software and SGI tools on the system disk and on
the tape or CD-ROM that you use in the event of a system crash.
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TCP/IP (Transmission Control Protocol/Internet Protocol)
A set of networking protocols for wide area networks (WANs) that is also gaining
popularity on local area networks (LANs).

thumbscrew

The ridged knob attached to a screw in a cable connector. You turn the thumbscrew to
secure the connector to an outlet.

Toolchest

The menus in the upper left-hand corner of the desktop. From the Toolchest, you can
select system tools such as the System Manager and Software Manager.

upgrade (hardware)

Hardware that you add to the basic workstation that increases performance, such as
additional memory and option boards.

unmount

To cause a filesystem that is accessible from a specific directory on your workstation to
be temporarily inaccessible.

user ID

A number that uniquely identifies a user to the system.

window

A portion of the screen with text or graphics that you can manipulate.

workstation

The physical hardware that contains the CPU, graphics boards, a system disk, and a
power supply. You connect it to a monitor, keyboard, and mouse to configure a working
system. It is also sometimes referred to as the chassis.

wrist strap

A band with a loop for your wrist at one end and copper foil at the other. You attach the
end with the foil to a metal part of the workstation and place the loop around your wrist.
You use the strap whenever you work with internal components of the workstation to
avoid electrical shocks to yourself and the components. See also static electricity.
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A

adapter board. See  option board
addresses, for external devices,  92-93
audio devices

external devices,  100-102
installing,  92, 100-102

audio ports
cable pinout assignments,  194-195
side panel location,  5

audio-visual module
removing,  77-80
replacing,  142-148

B

backups,  108, 110

C

cable pinout assignments
audio ports,  194-195
composite video (RCA) port,  195
digital video in/out port,  197-198
digital video option port,  201-202
Ethernet 10-Base T port,  191-192
keyboard and mouse,  192
monitor,  198-199
parallel port,  190-191
Presenter 1280 flat panel adapter,  200-201

SCSI port,  192-194
serial ports,  190
stereo view,  199
S-video port,  196

cables
connecting Ethernet 10-Base T,  7
connecting external,  7-10
connecting modem,  203
connecting monitor,  9
connecting mouse and keyboard,  7
connecting option board,  71
connecting power,  10
connecting printer/dumb terminal,  202
connecting SCSI,  91, 94, 96
connecting serial,  100

camera. See O2 Camera
CD-ROM, replacing,  158-175
CE notice,  180
chassis, replacing,  176-177
Chinese Class A regulatory notice,  182
CMN number,  180
composite video (RCA) port, cable pinout

assignments,  195
confidence tests,  107
connecting cables

Ethernet 10-Base T,  7
external,  7-10
modem,  203
monitor,  9
mouse and keyboard,  7
option board,  71
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power,  10
printer/dumb terminal,  202
SCSI,  91, 94, 96
serial,  100

console terminals,  99
CPU R12000class module, replacing,  126-136
CPU RM7000class module, replacing,  120-126
crash, system recovery,  108

D

daisy-chain
configurations,  95
guidelines,  95
maximum cable length,  91
SCSI devices,  91-98
SCSI terminator,  91

DCD. See Dual Channel Display (DCD) board
diagnostic tests

confidence,  107
Interactive Diagnostic Environment (IDE),  107
power-on,  106

dial and button boxes,  99
digital media software tools,  16
digital video option port, cable pinout assignments,

201-202
digitizer tablets,  99
dimensions of workstation,  208
DIMM banks

locating,  34
minimum configuration,  33
populating,  34-35
See also memory modules

DIMM. See memory modules
disabling system maintenance (PROM) password,

111
disk space, managing,  87

double inline memory modules. See memory
modules

drive
installing second internal,  75-87
removing second internal,  87-91
replacing system,  137-142
verifying installation,  87

Dual Channel Display (DCD) board
description,  51
installing,  51-66
removing,  66
See also option board
verifying installation,  73-74

dumb terminal serial cable,  202

E

electromagnetic emissions,  180-182
electrostatic discharge, regulatory notice,  183
ergonomic information,  185-187
ESD. See electrostatic discharge
Ethernet 10-Base T

cable pinout assignments,  191-192
connecting cable,  7

external devices
connecting audio and video devices,  100-102
connecting SCSI,  92-93
connecting serial,  99-100
setting addresses,  92

F

faceplate
removing screws,  58-59
replacing,  64-66, 126-128

FCC notice (USA only),  180
front view
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O2 Camera,  18
workstation,  2

G

guidelines, Visual Display Terminal,  185

H

hard drive
installing second internal,  75-87
removing second internal,  87-91
replacing system,  137-142
verifying installation,  87

heat sink,  130
host chip

PCI tray,  25, 38, 48
serial number,  25, 38

I

IDE tests. See Interactive Diagnostic Environment
tests

Industry Canada Notice (Canada only),  181
InfoSearch,  14
installing

audio devices,  92, 100-102
DIMMs,  32-36
Dual Channel Display (DCD) board,  51-66
jumper,  111
memory modules,  32-36
O2 Camera,  16-20
online manual,  13
option board,  51-66
PCI board on R12000class,  47-49
PCI board on RM7000class,  38-44
PCI tray in an R12000class workstation,  63-64

PCI tray in an RM7000class workstation,  60-63
SCSI devices,  91-98
second internal drive,  75-87
serial devices,  99
system module,  69-72
video devices,  100-102

Interactive Diagnostic Environment (IDE) tests,  107
internal drive

installing second,  75-87
removing second,  87-91
replacing system,  137-142
verifying installation,  87

IRIX software version,  117

J

jumper
installing,  111
removing,  114

K

Kensington lock and cable,  21-23
keyboard

cable pinout assignments,  192
confidence tests,  107
connecting cable,  7

Korean Class A regulatory notice,  182

L

laser compliance statement,  183
lockbar

attaching,  21
removing,  23
See also Kensington lock and cable

Logitech Magellan 3D input device,  99
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M

managing disk space,  75
manufacturer’s declaration of conformity,  180
memory modules

installing,  32-36
minimum configuration,  33
removing,  36-37
verifying hardware installation,  73-74

microphone, O2 Camera,  19
MIDI devices,  99, 100, 204, 206
modems,  99, 203-204
monitor

cable pinout assignments,  198-199
confidence tests,  107
connecting cable,  9
connecting O2Camera,  20

mouse
confidence tests,  107
connecting cable,  7
keyboard pinout assignments,  192

N

network cable. See Ethernet 10-Base T
nvram corruption,  178

O

O2 Camera
cable pinout assignments,  197
connecting to workstation,  8, 17
description,  16
front view,  18
installing,  16-20
microphone,  19
monitor set-up,  20
technical specifications,  207

O2Cam. See O2 Camera
online manual

installing,  13
locating,  12-13
SGI Technical Publications Library,  14

optical mouse,  99
option board

cable connecting,  71
Dual Channel Display (DCD),  51
installing,  51-66
removing,  66
verifying hardware installation,  73-74

optional drive bay
locating,  77
R12000class workstation,  75
removing panel,  80

ordering replacement parts,  117
overview of workstation,  1

P

parallel port, cable pinout assignments,  190-191
parts, ordering replacement,  117
password, diabling system maintenance (PROM),

111
PCB. See printed circuit board
PCI board

checking serial number,  25
installing

R12000class workstation,  47-49
RM7000class workstation,  38-44

I/O connector,  40, 46, 48, 50
removing

R12000class workstation,  50
RM7000class workstation,  44-47

verifying installation,  74
PCI connector,  40, 60, 132
PCI tray
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definition,  218
host chip,  25, 38, 48
installing

R12000class,  63-64
RM7000class,  60-63

locating serial number,  25
PCB,  178
releasing,  38, 44-45, 57, 60, 120, 128
removing

R12000class,  58-60
RM7000class,  57-58

replacing,  42-44
peripherals

audio and video devices,  100-102
SCSI devices,  91-98
second hard drive,  75-87
serial devices,  99-100

physical environment specifications,  208
power cable

connecting,  10
removing,  28

power requirements,  208
power supply

definition,  220
replacing,  149-157
specifications for O2+,  208

powering off workstation,  15
power-on tests,  106
Presenter 1280 flat panel adapter

cable pinout assignments,  200-201
confidence tests,  107

printed circuit board (PCB),  178
printer, serial cable,  202
product support,  115
PROM password, disabling,  111

Q

Quick Answers,  14

R

R12000class CPU module, replacing,  126-136
rear view

R12000class workstation,  4
RM7000class workstation,  3

recovery, system crash,  108
registering your workstation,  12
regulatory specifications

CE notice and Manufacturer’s Declaration of
Conformity,  180

Chinese Class A regulatory notice,  182
CMN number,  180
electromagnetic emissions,  180-182
electrostatic discharge,  183
FCC notice (USA) only,  180
Industry Canada notice (Canada only),  181
Korean Class A regulatory notice,  182
shielded cables,  182
VCCI notice (Japan only),  182

removing
audio-visual module,  77-80
DIMMs,  36-37
Dual Channel Display (DCD) board,  66
jumper,  114
lockbar,  23
memory modules,  36-37
option board,  66
PCI board on R12000class,  50
PCI board on RM7000class,  44-47
PCI tray in an R12000class workstation,  58-60
PCI tray in an RM7000class workstation,  57-58
power cable,  28
second internal drive,  87-91
system module,  27-32
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repetitive strain injuries. See ergonomic information
replacement parts, ordering,  117
replacing

audio-visual module,  142-148
CD-ROM,  158-175
chassis,  176-177
faceplate,  64-66
outer cover,  170
PCB on PCI tray,  178
PCI tray,  42-44
power supply,  149-157
R12000class CPU module,  126-136
RM7000class CPU module,  120-126
system drive,  137-142
system module,  119

RM7000class CPU module, replacing,  120-126

S

safety,  179, 183-185
SCSI

cable pinout assignments,  192-194
confidence tests,  107
configurations,  95
connecting cables,  91, 94, 96, 167
connecting external devices,  92-93
daisy-chain,  91-98
installing devices,  91-98
maximum cable length,  91
setting address,  92-93
terminator,  91
verifying installation,  97

serial cable
connecting,  100
modem,  203
printer/dumb terminal,  202

serial connectors
location,  99
pinout assignments,  190

serial devices
external devices,  99-100
installing,  99
modem cable,  203
printer/dumb terminal cable,  202

serial number
host chip,  25, 38
locating,  23-25
PCI tray,  25

serial ports, cable pinout assignments,  190
setting the SCSI address,  92-93
SGI support,  115
SGI Technical Publications Library,  xvii, 14
shielded cables, regulatory notice,  182
shutdown, system,  15
side panel, audio and video ports,  5
Spaceball,  99
specifications for power,  208
stereo view, cable pinout assignments,  199
support, SGI,  115
S-video port, cable pinout assignments,  196
system crash recovery,  108
system drive, replacing,  137-142
system module

display options slot,  52
faceplate. See faceplate
installing,  69-72
removing,  27-32
replacing,  119

T

technical specifications, physical environment,  208
terminator, SCSI,  91
tests, diagnostics

confidence,  107
Interactive Diagnostic Environment (IDE),  107
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power-on,  106
turning workstation on or off,  15

U

unlocking, workstation,  23

V

VCCI notice (Japan only),  182
verifying

DIMM installation,  73-74
hard drive installation,  87
memory,  73-74
option board installation,  73-74
PCI installation,  74
SCSI devices,  97

video devices
external devices,  100-102
installing,  100-102

video ports
cable pinout assignments,  197-198
side panel location,  5

Visual Display Terminal (VDT) guidelines,  185

W

workstation
attaching lockbar,  21
front view,  2
locating serial number,  23-25
locking,  21
parts,  6
rear view

R12000class,  4
RM7000class,  3

registering,  12

side view,  5
turning on or off,  15
unlocking,  23




